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Návod na prácu s digitálnym modelom reliéfu v aplikácii QGIS 

 

V tomto návode sú uvedené a popísané základné postupy a nástroje pre prácu s digitálnymi 

výškovými modelmi (DMR, DMP) v aplikácii QGIS. Produkty leteckého laserového skenovania 

Digitálny model reliéfu 5.0 (DMR 5.0) a Digitálny model povrchu 1.0 (DMP 1.0), poskytované 

Geodetickým a kartografickým ústavom Bratislava, je možné bezodplatne stiahnuť priamo  

z webovej aplikácie Mapový klient ZBGIS vo formátoch ESRI GRID a TIFF, alebo získať na základe 

objednávky vo formátoch ESRI GRID, TIFF a ASC v súradnicových systémoch: 

▪ S-JTSK[JTSK03] (kód EPSG:8353) s výškami v Baltskom výškovom systéme po vyrovnaní [Bpv] 
(kód EPSG:8357) 

▪ ETRS89-TM34 (kód EPSG:3046) s výškami hETS89 (elipsoidická výška v systéme ETRS89  
nad elipsoidom GRS80) 

Viac informácií nájdete na Geoportáli.  

Návod bol robený v aplikácii QGIS verzia 3.22.2 (vydaná 17.12.2022), ktorú je možné spolu 

s ostatnými verziami stiahnuť bezodplatne na stránke https://qgis.org/downloads/. 

Užívateľská príručka anglickom jazyku:  
▪ QGIS verzia 3.22: https://docs.qgis.org/3.22/en/docs/index.html 

Upozornenie: Názvy priečinkov a súborov, ktoré sa v budú v aplikácii používať, by mali byť 
pomenované bez diakritiky a medzier, pretože niektoré nástroje s tým môžu mať problém. 
 

1. Pridanie rastra DMR do projektu 
 

Na pridanie rastra DMR alebo DMP do aplikácie QGIS treba v hlavnom menu kliknúť na panel  
Layer → Add Layer → Add Raster Layer: 

 
Otvorí sa okno Data Sorce Manager| Raster, kde v časti Source type vybrať File, v časti Source vybrať 
požadovaný raster (pre ESRI GRID je to súbor s príponou .adf, pre TIFF súbor s koncovkou .tif)  
a potom kliknúť na tlačidlo Add: 

 

https://www.qgis.org/en/site/
https://zbgis.skgeodesy.sk/mkzbgis/sk/teren/export?
https://www.geoportal.sk/sk/udaje/lls-dmr/
https://qgis.org/downloads/
https://docs.qgis.org/3.22/en/docs/index.html
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Následné sa do bočného panelu Layers pridá DMR a zobrazí v mapovom okne: 

 
Poznámka: Pre prácu s DMR v aplikácii QGIS je najlepšie použiť formát TIFF alebo GeoTIFF. 

 
Zobrazenie „No Data“ buniek rastra 
Aby sa automaticky zobrazovali tzv. „No Data“ (prázdne) bunky rastra DMR  (slúžia len na doplnenie 

mriežky rastra do úplného tvaru (obdĺžnik, štvorec) a neobsahujú hodnoty výšky) ako transparentné 

(priehľadné) tak je potrebné  v časti Properties→Transparency skontrolovať, či je označená políčko 

No data value: 
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Pri zobrazení sa potom budú tieto bunky automaticky zobrazovať ako transparentné (priehľadné) 

a nebudú tak prekrývať ostatné vrstvy v mapovom okne: 

 

 

Nastavenie súradnicového systému 

Po pridaní DMR do projektu treba tiež skontrolovať nastavený súradnicový systém tak, že v paneli 

Layers kliknúť pravým tlačidlom myši na vrstvu DMR a vybrať Properties: 
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V časti Source v políčku Assigned Coordinate Reference System (CRS) je súradnicový systém DMR, 

v akom sa DMR zobrazuje v projekte: 

 
 

Ak tam bude uvedená hodnota napr. invalid projection, tak pre správne polohové zobrazenie rastra 

treba nastaviť jeho súradnicový systém po kliknutí na tlačidlo  (Select CRS). Otvorí sa okno 

Coordinate Reference System Selector, kde do políčka Filter zadať EPSG kód patriaci prísušnému 

súradnicovému systému: 

• 8353 pre S-JTSK [JTSK03] Krovak East North, 

• 3046 pre ETRS89-TM34. 
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Vyhľadaný súradnicový systém sa zobrazí v okne Coordinate Reference System, kde ho treba označiť 

ľavým tlačidlom myši a potom kliknúť na tlačidlo OK: 

 
 

Raster má tak v projekte nastavený správny súradnicový systém. Po odstránení z projektu sa ale 

takéto nastavenie súradnicového systému rastra nezachová. Pre trvalé priradenie súradnicového 

systému treba použiť funkciu Assign projection, ktorá sa nachádza v hlavnom menu v paneli 

Raster→Projections: 

 

Otvorí sa okno Assign projection, kde v časti Input layer vybrať raster a v časti Desired CRS vybrať 

požadovaný súradnicový systém a kliknúť na tlačidlo Run: 
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Súradnicový systém rastra je tak zadefinovaný 

 

Súradnicový systém projektu, v ktorom sa budú zobrazovať všetky pridané vrstvy, je možné nastaviť 

v ľavej dolnej časti mapového okna aplikácie po kliknutí na tlačidlo  (Current CRS): 
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Poznámka: Informácie o správnom nastavení súradnicových systémov a transformácií používaných 

na území Slovenska sú uvedené v návode Súradnicový systém S-JTSK[JTSK03] v QGIS:  

https://www.geoportal.sk/files/gz/s-jtsk_jtsk03_v_qgis.pdf. 

 

 

Vytvorenie rastrových pyramíd 

Rastrové vrstvy s veľkým rozlíšením môžu spomaľovať prácu v aplikácii. Vytvorením kópií rastrových 

údajov (tzv. „pyramíd“) s nižším rozlíšením je možné zlepšiť výkon a rýchlosť zobrazovania, pretože 

aplikácia potom vyberá najvhodnejšie rozlíšenie na použitie v závislosti od úrovne priblíženia 

v mapovom okne. Rastrové pyramídy je možné vytvoriť v Properties (nastaveniach) vrstvy rastra 

v časti Pyramids, kde treba vyplniť požadované parametre a kliknúť na tlačidlá Build Pyramids 

a potom OK: 

• Overview format – External (pyramídy budú v tomto prípade vytvorené v adresári 

pôvodného rastra s rovnakým názvom a príponou .ovr). Pri formáte GeoTIFF je možné 

použiť aj metódu Internal. 

• Resampling method - vybrať metódu pre resampling (prevzorkovanie), ktorá bude použitá 

pri tvorbe rastrových pyramíd (napr. Bilinear). 

• Resolutions - z ponuky vybrať kliknutím požadované rozlíšenia, pre ktoré sa vytvoria 

jednotlivé úrovne pyramídy. 

https://www.geoportal.sk/files/gz/s-jtsk_jtsk03_v_qgis.pdf
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Po ukončení procesu sa v adresári s rastrom DMR vytvoria pyramídy do súboru s príponou .ovr: 

 
 

Poznámka: Pre vytváranie rastrových pyramíd treba mať povolenie na zápis do adresára, kde je 

uložený raster DMR. 

 

2. Export do iných formátov 
 

DMR je možné vyexportovať do rôznych formátov (GeoTIFF, GeoPackage a pod.) tak, že v paneli 

Layers treba kliknúť pravým tlačidlom myši na vrstvu DMR a vybrať Export → Save As: 
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Otvorí sa okno Save Raster Layer as, kde treba vyplniť požadované parametre a potom kliknúť  
na tlačidlo OK: 

• Output mode – označiť políčko Raw data. 

• Format - vybrať formát výstupného súboru. 

• File name - zadať názov a umiestnenie výstupného súboru. 

• CRS - vybrať výstupný súradnicový systém. 

• Resolution – zadefinovať rozlíšenie (veľkosť bunky) pretransformovaného rastra (voliteľný 

parameter - ak sa nevyplní, aplikácia si sama vypočíta hodnotu podľa rozlíšenia vstupného 

rastra). 

 

Druhou možnosťou (napr. pre export do ASC gridu) je použiť nástoj Translate (convert format), 

ktorý sa nachádza v paneli Raster → Conversion: 
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Po spustení nástroja treba vyplniť požadované parametre a kliknúť na tlačidlo Run: 

• Input layer – vybrať vstupný raster. 

• Converted - zadať názov, formát a umiestnenie výstupného súboru. 

 
 

3. Zmena priestorového rozlíšenia 
 

Priestorové rozlíšenie rastra DMR je možné zmeniť (napr. z 1 x 1 m na 10 x 10 m) použitím nástroja 

Resampling, ktorý sa nachádza v paneli nástrojov Processing Toolbox→SAGA→Raster tools: 
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Po spustení tohto nástroja sa otvorí okno Resampling, kde treba vyplniť požadované parametre  

a potom kliknúť na tlačidlo Run: 

• Grids - vybrať vstupný DMR. 

• Upscaling Method - výber interpolačnej metódy (pre zväčšovanie), napr. Nearest Neighbor. 

• Downscaling Method - výber interpolačnej metódy (pre zmenšovanie), napr. Nearest 

Neighbor. 

• Cellsize - veľkosť novej bunky rastra DMR. 

• Resampled Grids - kliknúť na Save to File... a zadať názov a umiestnenie výstupného DMR. 

 
Po vygenerovaní rastra skontrolovať jeho súradnicový systém v časti Properties → Source → 

Assigned Coordinate Reference System (CRS). Formát výstupného DMR so zmenením priestorovým 

rozlíšením je SDAT. Pre export do iného formátu (napr. GeoTIFF) je možné použiť postup uvedený  

v 2. kapitole. 

 

Upozornenie: pri zmenšení priestorového rozlíšenia pôvodného DMR (napr. z 1 x 1 m na 10 x 10 m) 

treba počítať so stratou výškovej a polohovej presnosti pri porovnaní s pôvodným DMR alebo pri 

porovnaní s nameranými údajmi v teréne. 
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4. Nastavenie symboliky a vytvorenie tieňovaného reliéfu (Hillshade) 
 

Zmenu symboliky DMR je možné vykonať vo vlastnostiach vrstvy Properties v časti Symbology, 

kde vyplniť požadované parametre a nakoniec kliknúť na tlačidlo Apply a potom OK: 

• Render type - vybrať možnosť Singleband pseudocolor.  

• Interpolation vybrať možnosť Linear. 

• Color Ramp vybrať farebnú škálu napr.  Spectral, prípadne označiť možnosť Invert Color 

Ramp (opačné zobrazenie farebnej škály) a potom kliknúť na ikonku Classify.  

• Layer Rendering – v tejto časti  je možné nastaviť jas (Brightness), kontrast (Contrast) 

a sýtosť (Saturation) farieb. 

• Resampling – v políčkach Zoomed: in a out vybrať metódu pre resampling (prevzorkovanie) 

rastra pri jeho približovaní/oddiaľovaní v mapovom okne:  napr. Bilinear alebo Cubic, 

v políčku Oversampling (prevzorkovanie) nastaviť hodnotu napr. 2,00 a označiť políčko Early 

resampling pre skoré prevzorkovanie.  
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Symbolika DMR sa zmenila na základe hodnoty výšky: 

 
 

Okrem prednastavených farebných škál je takisto možné vytvoriť si aj vlastnú farebnú škálu, tak že 

v políčku Color Ramp vybrať možnosť Create Create New Color Ramp: 
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Otvorí sa okno Color ramp type, kde vybrať možnosť Gradient a kliknúť na tlačidlo OK: 

 
Otvorí sa okno Select Color Ramp, kde treba nastaviť počet hodnôt farebnej škály, ktoré predstavujú 

značky Gradient Stop . Značka Gradient Stop sa vytvorí po dvojkliku na zvolené miesto farebnej 

stupnice: 

 
Presnú polohu značky Gradient Stop v rámci farebnej stupnice je možné upraviť po kliknutí 

pohybom myši alebo v políčku Relative position zadaním jej polohy v rámci stupnice v %: 

 
Značka Gradient Stop sa dá vymazať po kliknutí na tlačidlo Delete Stop. 

Každej značke Gradient Stop po kliknutí myšou je možné nastaviť požadovanú farbu, podľa ktorých 

sa vyskladá farebná škála pre ofarbenie rastra DMR: 
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Po vytvorení požadovanej farebnej škály kliknúť na tlačidlo OK a následne ju treba uložiť po kliknutí 

na Save Color Ramp, kde sa zadá jej názov: 

 

 
 

Vytvorená farebná škála sa nachádza v Color ramp → All Color Ramps: 
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Raster DMR zobrazený v nastavenej symbolike: 

 
 

Tieňovaný reliéf - Hillshade (t.j. 3D reprezentácia terénu v odtieňoch sivej, ktorá zodpovedá 

zatieneniu DMR podľa zvolenej relatívnej pozície Slnka) je možné vytvoriť tiež vo vlastnostiach vrstvy 

Properties v časti Symbology. V políčku Render type treba vybrať Hillshade, v políčku Altitude 

nastaviť výškový uhol svetelného zdroja, v políčku Azimuth zadať azimut svetelného zdroja 

osvetľujúceho DMR a do políčka Z Factor nastaviť mierkový faktor pre hodnoty buniek (výšky) rastra 

(hodnota 1 znamená, že výšky budú vykreslené bez zmeny mierky).  Pri označení políčka 

Multidirectional sa vytvorí tzv. Multidirectional Hillshade (kombinácia osvetlenia zo 4 rôznych 

zdrojov s azimutmi 225°, 270°, 315° a 360°). V časti Layer Rendering je možné nastaviť jas 

(Brightness), kontrast (Contrast) a sýtosť (Saturation) farieb, v políčkach  Resampling – v políčkach 

Zoomed: in a out vybrať metódu pre resampling (prevzorkovanie) rastra pri jeho 

približovaní/oddiaľovaní v mapovom okne:  napr. Bilinear alebo Cubic a označiť políčko Early 

resampling pre skoré prevzorkovanie. Nakoniec kliknúť na Apply a potom OK: 
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Vytvorený Hillshade (Altitude=45°, Azimuth=315°): 
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Hillshade je tiež možné vytvoriť ako samostatný raster pomocou nástroja Hillshade, ktorý sa 

nachádza v paneli nástrojov Raster → Analysis: 

 
Po spustení tohto nástroja je potrebné v políčku, ďalej vyplniť všetky potrebné parametre a kliknúť 

na tlačidlo Run: 

• Input layer - vybrať vstupný raster. 

• Azimuth of the light - zadať azimut svetelného zdroja osvetľujúceho DMR. 

• Altitude of the light - nastaviť výškový uhol svetelného zdroja. 

• Z Factor - nastaviť mierkový faktor pre hodnoty buniek (výšky) rastra (hodnota 1 znamená,  

že výšky budú vykreslené bez zmeny mierky). 

• Multidirectional shading - po označení políčka sa vytvorí tzv. Multidirectional Hillshade 

(kombinácia osvetlenia zo 4 rôznych zdrojov s azimutmi 225°, 270°, 315° a 360°). 

• Hillshade - vyplniť názov, formát a umiestnenie výstupného rastra. 
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Vytvorený Hillshade (Multidirectional shading): 

 
 

Postup nastavenia farebnej symboliky rastra DMR so zvýraznením priebehu terénu podľa 

vytvoreného Hillshade: 

a) nastavenie ofarbenia rastra DMR podľa zvolenej farebnej škály: 
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b) vytvorenie rastra Hillshade a nastavenie jeho priehľadnosti (Global Opacity) vo vlastnostiach 

vrstvy Properties → Transparency: 

 

 
 

Slider pre nastavenie priehľadnosti vrstvy je možno umiestniť priamo do panela Layers, kde 

sa zobrazí nad legendou s nastavenou symbolikou vrstvy: 
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Slider je možné nastaviť v Properties → Legends, kde v časti Embedded Widgets in Legend -

Available widgets kliknúť na položku Opacity slider, potom kliknúť na tlačidlo  

a nakoniec kliknúť na tlačidlá Apply a OK : 

 
 

c) v paneli Layers umiestniť raster Hillshade nad raster DMR: 
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5. Identifikácia hodnoty výšky 
 

Hodnotu bunky rastra vo zvolenom bode (pri DMR zodpovedá výške terénu), je možné v mapovom 

okne zistiť pomocou nástroja Identify Features , ktorý sa nachádza v paneli Attribute Toolbar: 

 
Panel Attribute Toolbar je možné zapnúť po kliknutí na panel View v hlavnom menu, tam vybrať 

Toolbars a označiť Attribute Toolbar. 

Po označení ikonky  tohto nástroja je možné v mapovom okne kliknúť vrstvu DMR vo zvolenom 

bode: 

 
 

Otvorí sa okno Identify Results s výsledkami identifikácie, kde je v stĺpci Value uvedená hodnota 

výšky bunky DMR, čiže výška terénu v danej lokalite: 
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6. Transformácia do iného polohového súradnicového referenčného systému 
 

Informácie o správnom nastavení súradnicových systémov a transformácií používaných na území 

Slovenska sú uvedené v návode Súradnicový systém S-JTSK[JTSK03] v QGIS: 

https://www.geoportal.sk/files/gz/s-jtsk_jtsk03_v_qgis.pdf. 

Na transformáciu polohového súradnicového systému rastrových údajov je možné použiť dva 
spôsoby: 
a)  V paneli Layers kliknúť pravým tlačidlom myši na vrstvu, vybrať Export a tam Save As...: 

 
Otvorí sa okno Save Raster Layer as..., kde treba vyplniť potrebné parametre a potom kliknúť  
na tlačidlo OK: 

• Format - vybrať formát výstupného súboru. 

• File name - zadať názov a umiestnenie výstupného súboru. 

• CRS - vybrať výstupný súradnicový systém. 

• Resolution – zadefinovať rozlíšenie (veľkosť bunky) pretransformovaného rastra (voliteľný 

parameter - ak sa nevyplní, aplikácia si sama vypočíta hodnotu podľa rozlíšenia vstupného 

rastra). 

 

https://www.geoportal.sk/files/gz/s-jtsk_jtsk03_v_qgis.pdf
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b)  Nástroj Warp (reproject), ktorý sa nachádza v paneli Raster → Projections: 

 
Po spustení tejto funkcie sa otvorí okno Warp (reproject), kde treba vyplniť potrebné parametre  

a potom kliknúť na tlačidlo Run:  

• Input layer - vybrať vstupný raster. 

• Source CRS - vybrať vstupný súradnicový systém. 

• Target CRS - vybrať výstupný súradnicový systém. 

• Resampling method to use - zvoliť metódu pre prevzorkovanie (resampling) rasta. 

• Output file resolution in target georeferenced units – zadefinovať rozlíšenie (veľkosť bunky) 

pretransformovaného rastra (voliteľný parameter - ak sa nevyplní, aplikácia si sama 

vypočíta hodnotu podľa rozlíšenia vstupného rastra). 

• Reprojected - zadať názov, umiestnenie a formát výstupného súboru. 
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7. Transformácia do iného výškového referenčného systému 
 

Hodnoty buniek (výšky) rastra DMR 5.0 alebo DMP je  možné pretransformovať do jedného 

z nasledujúcich výškových referenčných systémov záväzných na území Slovenska: 

▪ Baltský výškový systém po vyrovnaní - Bpv (1957), kód EPSG:8357 

▪ Európsky vertikálny referenčný systém - EVRS (EVRF2007), kód EPSG:5621  

▪ elipsoidická výška v systéme ETRS89 nad elipsoidom GRS80 - hETS89, kód EPSG:4937 

 

Na transformáciu výšok je treba použiť digitálne referenčné výškové modely, ktoré je možné 

stiahnuť vo formáte GTX na Geoportáli v sekcii Geodetické základy→Na stiahnutie: 

▪ Digitálny výškový referenčný model - DVRM05: model je určený na prevod elipsoidických 

výšok určených GNSS v systéme ETRS89 do systému nadmorskýchv(normálnych) výšok Bpv. 

Obsahuje hodnoty výšok kvázigeoidu DVRM05 nad elipsoidom GRS80. 

▪ Digitálny model kvázigeoidu - DMQSK2014-E: model je určený na prevod elipsoidických 

výšok určených GNSS v systéme ETRS89 do systému nadmorských (normálnych) výšok 

EVRS (EVRF2007). Obsahuje hodnoty výšok kvázigeoidu DMQSK2014-E nad elipsoidom 

GRS80. 

 

Transformácia výšok Bpv na výšky hETS89 

1) Do nového projektu pridať stiahnutý digitálny výškový referenčný model DVRM05 

(Slovakia_ETRS89h_to_Baltic1957.gtx) pomocou funkcie Layer → Add Layer → Add Raster 

Layer:  

 
DVRM05 je v súradnicovom referenčnom systém WGS84 (kód EPSG:4326). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.geoportal.sk/sk/geodeticke-zaklady/na-stiahnutie/
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2) Do toho istého projektu pridať DMR s výškami v Bpv napr. v súradnicovom systéme  

S-JTSK[JTSK03] tiež pomocou funkcie Layer → Add Layer → Add Raster Layer:  

 
UPOZORNENIE: Pre správne polohové zobrazovanie rastrov je potrebné mať v QGIS 

nastavené správne transformácie podľa návodu Súradnicový systém S-JTSK[JTSK03] v QGIS:  

https://www.geoportal.sk/files/gz/s-jtsk_jtsk03_v_qgis.pdf. 

 

3) Transformácia výšky Bpv na hETS89  - použije sa digitálny referenčný výškový model DVRM05 

(Slovakia_ETRS89h_to_Baltic1957.gtx) a nástroj Raster calculator, ktorý sa nachádza v paneli 

Processing Toolbox → Raster analysis: 

 

https://www.geoportal.sk/files/gz/s-jtsk_jtsk03_v_qgis.pdf
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Otvorí sa okno Raster calculator, kde do políčka Expression zadať podmienku v tvare:   

"dmr_Bpv@1" + "Slovakia_ETRS89h_to_Baltic1957@1", kde dmr_Bpv@1 je vstupný DMR  

s výškou Bpv. Do podmienky zadať presný názov vstupného rastra DMR, ktorý je možný vidieť 

v časti Layers, kde stačí dvakrát kliknúť ľavým tlačidlom myši na vrstvu a automaticky sa pridá 

po políčka Expression. V políčku Reference layer(s) (used for automated extent, cellsize, and 

CRS) vybrať vrstvu DMR a kliknúť na tlačidlo OK: 

 
Do políčka Output zadať umiestnenie, názov a formát výstupného súboru a nakoniec 

kliknúť na tlačidlo Run: 

 
Po dokončení procesu sa do projektu pridá výstupný raster s výškami hETS89 . Hodnotu výšok 

vstupného DMR (dmr_jtsk03_Bpv) a výstupného DMR (dmr_jtsk03_Hetrs89) je možné 
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porovnať  pomocou nástroja Identify Features , ktorý sa nachádza v paneli Attribute 

Toolbar,  podľa postupu uvedeného v 5. kapitole: 

 
4) Transformácia polohového súradnicového referenčného systému – ak je potrebné získať 

DMR s výškami hETS89  v inom polohovom súradnicovom referenčnom systéme, napr. 

ETRS89 (kód EPSG:4258), je možné použiť postup transformácie uvedený v 6. kapitole.  

 

Transformácia výšok hETS89 na výšky Bpv - pri transformácii výšok sa tiež použije digitálny výškový 

referenčný model DVRM05 (Slovakia_ETRS89h_to_Baltic1957.gtx) . Postup je podobný ako 

v predchádzajúcom prípade s tým, že v nástroji Raster calculator treba do políčka Expression zadať 

podmienku v tvare: "dmr_Hetrs89@1" - "Slovakia_ETRS89h_to_Baltic1957@1", kde 

dmr_Hetrs89@1 je vstupný DMR s výškami hETS8 (do podmienky zadať presný názov vstupného 

rastra DMR). 

 

 

Transformácia výšok hETS89 na výšky EVRS(EVRF2007) 

1) Do nového projektu pridať stiahnutý digitálny model kvázigeoidu DMQSK2014-E 

(Slovakia_ETRS89h_to_EVRF2007.gtx) pomocou funkcie Layer→ Add Layer →  

Add Raster Layer:  

 
DMQSK2014-E je v súradnicovom referenčnom systém WGS84 (kód EPSG:4326). 
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2) Do toho istého projektu pridať DMR s výškami v hETS89 vytvorený v časti Transformácia výšok 

Bpv na výšky hETS89  alebo priamo poskytovaný DMR 5.0 v ETRS89-TM34 s výškami hETS89: 

 
UPOZORNENIE: Pre správne polohové zobrazovanie rastrov je potrebné mať v QGIS 

nastavené správne transformácie podľa návodu Súradnicový systém S-JTSK[JTSK03] v QGIS:  

https://www.geoportal.sk/files/gz/s-jtsk_jtsk03_v_qgis.pdf. 

 

3) Transformácia výšky hETS89 na EVRS(ETRF2007) - použije sa digitálny model kvázigeoidu 

DMQSK2014-E (Slovakia_ETRS89h_to_EVRF2007.gtx) a nástroj Raster calculator, ktorý sa 

nachádza v paneli Processing Toolbox→Raster analysis. 

Otvorí sa okno Raster calculator, kde do políčka Expression zadať podmienku v tvare:   

"dmr_ Hetrs89@1" - " Slovakia_ETRS89h_to_EVRF2007 @1", kde dmr_Hetrs89@1 je 

vstupný DMR v systéme S-JTSK[JTSK03] s výškou Bpv. Do podmienky zadať presný názov 

vstupného rastra DMR, ktorý je možný vidieť v časti Layers, kde stačí dvakrát kliknúť ľavým 

tlačidlom myši na vrstvu a automaticky sa pridá po políčka Expression. V políčku Reference 

layer(s) (used for automated extent, cellsize, and CRS) vybrať vrstvu DMR a kliknúť na 

tlačidlo OK: 

 
 

 

 

 

https://www.geoportal.sk/files/gz/s-jtsk_jtsk03_v_qgis.pdf
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Do políčka Output zadať umiestnenie, názov a formát výstupného súboru a nakoniec kliknúť 

na tlačidlo Run: 

 
Po dokončení procesu sa do projektu pridá výstupný raster s výškami EVRS. Hodnotu výšok 

vstupného DMR (dmr_jtsk03_Hetrs89) a výstupného DMR (dmr_jtsk03_EVRS) je možné 

porovnať  pomocou funkcie Identify Features , ktorá sa nachádza v paneli Attribute 

Toolbar, podľa postupu uvedeného v 5. kapitole: 
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4) Transformácia polohového súradnicového referenčného systému – ak je potrebné získať 

DMR s výškami EVRS(EVRF2007) v inom polohovom súradnicovom referenčnom systéme, 

napr. ETRS89 (kód EPSG::4258), je možné použiť postup transformácie uvedený 

v 6. kapitole.  

 

Transformácia výšok EVRS(EVRF2007) na výšky hETS89 - pri transformácii výšok sa tiež použije 

digitálny model kvázigeoidu DMQSK2014-E (Slovakia_ETRS89h_to_EVRF2007.gtx). Postup je 

podobný ako v predchádzajúcom prípade s tým, že v nástroji Raster calculator treba do políčka 

Expression zadať podmienku v tvare: 

"dmr_EVRS@1" + " Slovakia_ETRS89h_to_EVRF2007.gtx", kde dmr_EVRS@1 je vstupný DMR 

s výškami EVRS(EVRF2007) (do podmienky zadať presný názov vstupného rastra DMR). 

 

8. Vytvorenie vrstevníc 
 

QGIS ponúka možnosť vizualizovať DMR vo forme vrstevníc vo vlastnostiach vrstvy Properties v časti 

Symbology, kde treba nastaviť požadované parametre a kliknúť na tlačidlo Apply a potom OK: 

• Render type – vybrať možnosť Contours. 

• Contorul Interval – vybrať výškový interval základných vrstevníc v metroch. 

• Contoru Symbol – vybrať symboliku (typ, hrúbku a farbu čiary) pre základné vrstevnice. 

 
• Index Contour Interval – vybrať symboliku pre hlavné vrstevnice. 

• Index Contour Symbol - vybrať symboliku (typ, hrúbku a farbu čiary) pre hlavné vrstevnice. 

• Layer Rendering - možnosť nastaviť jas (Brightness), kontrast (Contrast) a sýtosť (Saturation) 

farieb. 
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• Resampling – v políčkach Zoomed: in a out vybrať metódu pre resampling (prevzorkovanie) 

rastra pri jeho približovaní/oddiaľovaní v mapovom okne:  napr. Bilinear alebo Cubic, 

v políčku Oversampling (prevzorkovanie) nastaviť hodnotu napr. 2,00 a označiť políčko Early 

resampling pre skoré prevzorkovanie.  

 
 

DMR vizualizovaný vo forme vrstevníc: 

 
 

 



36 
 

Ak je potrebné z DMR vygenerovať vrstevnice do samostatnej vektorovej líniovej vrstvy, tak je 

možné použiť nástroj Contour, ktorá sa nachádza v hlavnom menu v paneli Raster → Extraction:  

 
Po jeho spustení sa otvorí okno, kde treba vyplniť požadované parametre a potom kliknúť na 

tlačidlo Run:  

• Input layer - vybrať raster DMR, z ktorého sa budú generovať vrstevnice. 

• Interval between contour lines - zadať výškový interval vrstevníc. 

• Produce 3D vector - označiť políčko, ak sú na výstupe potrebné vrstevnice, ktorých vertexy 

budú mať vyplnenú aj hodnotu súradnice Z (výška). 

• Contours - vyplniť názov, formát (napr. Shapefile) a umiestnenie výstupného súboru. 
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Vygenerované vrstevnice s výškovým intervalom 10 m: 

 
Vrstevnice je možné ďalej upraviť (generalizovať) pomocou nástroja Generalizer3. Tento nástroj 

(plugin) je potrebné najprv do QGIS nainštalovať. V hlavnom menu v paneli Plugins→Manage and 

Install Plugins vybrať All a do vyhľadávacie okna Search zadať názov nástroja a po jeho vyhľadaní 

kliknúť na tlačidlo Install plugin: 
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Nainštalovaný nástroj Generalizer sa nachádza v paneli Vector: 

 
 

Po kliknutí na tento nástroj sa otvorí okno Generalizer, kde treba vyplniť požadované parametre a 

potom kliknúť na tlačidlo OK: 

• Choose layer(s) - vybrať vrstevnice, ktoré sa budú generalizovať. 

• Algorithm(s)– po kliknutí na tlačidlo Add vybrať algoritmus, ktorý sa má použiť na 

generalizáciu (Generalizing), zjednodušenie (Symplifying) a vyhľadenie(Smoothing) vrstevníc 

a zadať jeho parametre (napr. Treshold, Weight,...) 

 
 

Viac informácií o algoritmoch pre generalizáciu je uvedených na stránkach:  

o https://github.com/giscan/Generalizer 

o  https://grasswiki.osgeo.org/wiki/V.generalize_tutorial. 

• Save outpu layer – označiť toto políčko a kliknúť na tlačidlo Browse, kde zadať umiestnenie 

a názov výstupného súboru (formát je automaticky nastavený na GeoPackage): 

https://github.com/giscan/Generalizer
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Po označení políčka Batch mode, je možné vybrať a použiť viacero generalizačných metód naraz po 

kliknutí na tlačidlo Add, napr.: 

 
 

Po kliknutí na tlačidlo OK sa vytvorí generalizovaná vrstva vrstevníc, ktorá sa pridá do panelu Layers  

označená ako memory, ktorá ale je len dočasná vrstva uložená len v pamäti počítača.  

 
Túto vrstvu je možné vyexportovať do zvoleného formátu pomocou nástroja Export → Save 

Feature Layer As po kliknutí pravým tlačidlom myši na vrstvu v paneli Layers: 
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Otvorí sa okno Save Vector Layer As, kde treba vyplniť požadované parametre a kliknúť na tlačidlo 

OK: 

•  Format – vybrať požadovaný formát výstupného súboru. 

•  File name – zadať názov a umiestnenie výstupného súboru. 

• Layer Name – zadať názov vrstvy (napr. pri formáte GeoPackage). 

• CRS – zadať súradnicový systém výstupného súboru. 
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Pôvodné vrstevnice: 

 
 

Vrstevnice po generalizácii: 

 
 

9. Odmeranie výškového profilu 
 

Na odmeranie výškového profilu je možné použiť nástroj (plugin) VoGIS Profil Tool, ktorý sa dá 

nainštalovať podobným postupom, ako je uvedený v 8. kapitole. Nainštalovaný nástroj sa potom 

nachádza v paneli Raster → VoGIS Profil Tool. Po kliknutí na tento nástroj sa otvorí okno, kde treba 

vyplniť požadované parametre a potom kliknúť na tlačidlo Create Profile: 

• Select rasters visible in current extent - po kliknutí na toto tlačidlo sa v spodnom okne zobrazí 

zoznam rastrov, ktoré sú zapnuté v paneli Layers. Z nich treba vybrať požadovaný DMR. 

• Digitized profile line – po kliknutí na tlačidlo Digitize (new) profile line je možné na DMR ručne 

nakresliť líniu, po ktorej bude prebiehať výškový profil. Línia sa ukončí kliknutím pravého 

tlačidla myši. 
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• Use profile line from line layer – túto možnosť zvoliť, ak sa má výškový profil vytvoriť  

na mieste existujúcej líniovej vrstvy, ktorá je tiež pridaná v projekte v paneli Layers. 

• Define Vertices- zvoliť jednu z možností: 

a) Distance between vertices – definuje vzdialenosť medzi bodmi výškového profilu, 

b) Number profile points at nodes and vertices – definuje počet bodov výškového profilu. 

 



43 
 

Následne sa otvorí okno s vygenerovaným výškovým profilom, ktorý je možné uložiť ako obrázok  

po kliknutí na ikonku Save the figure  alebo vyexportovať do rôznych formátov (Textfile, 

Excel/CSV, SHP, DXF) ako body alebo líniu:  

 
 

Zobrazenie vyexportovaných bodov profilu vo formáte Shapefile (SHP), kde v atribútovej tabuľke je 

možné nájsť súradnice bodu (X=Rechtswert, Y=Hochwert, Z=dmr (podľa názvu vstupného DMR)) 

a vzdialenosť od začiatku profilu (Profillaen): 
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Zobrazenie vyexportovanej línie profilu vo formáte DXF v CAD softvéri Bentley MicroStation V8i: 

 
 

 

10. Sklon terénu 
 

Z DMR je možné vypočítať uhol sklonu v stupňoch pre každú bunku rastra. Slúži na to nástroj Slope, 

ktorý sa nachádza v paneli Raster→Analysis. Po spustení nástroja sa otvorí okno, kde treba vyplniť 

požadované parametre a kliknúť na tlačidlo na Run: 

• Input layer - vybrať vstupný DMR. 

• Slope - zadať názov, formát a umiestnenie výsledného súboru. 
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Výsledný raster so znázornením sklonu terénu v stupňoch: 
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11. Vytvorenie výrezu a rozdelenie rastra DMR 
 

Výrez podľa vektorovej polygónovej vrstvy 

Výrez z rastra DMR podľa záujmového územia (vektorového polygónu) je možné urobiť pomocou 

nástroja: 

 1) Clip Raster with Polygon, ktorý sa nachádza v paneli Processing toolbox →   

     SAGA → Features – Features-Raster Tools: 

 
 

Po spustení nástroja treba vyplniť požadované parametre a kliknúť na tlačidlo Run: 

• Input - vybrať vstupný DMR. 

• Polygons - vybrať polygónovú vrstvu, podľa ktorej sa urobí výrez z DMR. 
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• Target Extent – vybrať možnosť  polygons. 

• Output -  zadať umiestnenie a názov výstupného súboru vo formáte SDAT: 

 
 

Na výstupe je raster vo formáte SDAT. Pre export do iných formátov (napr. GeoTIFF) je možné 

použiť postup uvedený v 2. kapitole. 

 
Výsledný výrez z DMR (čierno-biely) podľa zvoleného územia (fialový polygón): 
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Rozdelenie DMR na viacero častí podľa pravouhlej mriežky: 

DMR je možné rozdeliť na viacero menších častí, ktoré budú spolu presne susediť.  

Ako prvé si treba pripraviť vektorovú polygónovú vrstvu podľa , ktorej sa DMR bude orezávať.  

Pre orezanie je ideálna pravouhlá štvorcová alebo obdĺžniková mriežka. Pre rastre v súradnicovom 

systémeme S-JTSK[ JTSK03] alebo S-JTSK[JTSK] je možné použiť napr. aj klady mapových listov (napr. 

pre mierku 1:1000 alebo 1:2000), ktoré sa dajú bezodplatne stiahnuť vo formáte Shapefile a súr. 

systéme S-JTSK[JTSK] na stránke:  

https://www.geoportal.sk/sk/kataster-nehnutelnosti/na-stiahnutie/ 

 

Postup: 

a) Do projektu v QGIS si pripojiť DMR a polygónovú vrstvu, podľa ktorej sa DMR bude orezávať,  

a v paneli Layers ju umiestniť nad vrstvu DMR): 

 

Symboliku polygónovej vrstvy je možné nastaviť v Properties → Symbology: 

 

https://www.geoportal.sk/sk/kataster-nehnutelnosti/na-stiahnutie/
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Popis polygónovej vrstvy je možné nastaviť v Properties → Labels: 

 

b) V paneli Layers kliknúť pravým tlačidlom myši na polygónovú vrstvu  a potom v paneli 

s nástrojmi kliknúť na ikonku  (Select Features by area or single click): 

 

Pomocou tohto nástroja potom v mapovom okne označiť jeden alebo viacej polygónov, podľa 

ktorých ohraničenia sa z DMR urobí výrez: 
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c) Spustiť nástroj Clip Raster with Polygon a vyplniť potrebné parametre Input, Polygons, Target 

Extent, Output a označiť políčko Selected features only: 

 

Na výstupe je DMR orezaný podľa zvoleného polygónu: 

 

Takýmto spôsobom je možné DMR postupne rozdeliť na viacero častí: 
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2) Clip raster by mask layer, ktorý sa nachádza v paneli Raster → Extraction. Po spustení toho 

nástroja sa objaví okno, kde treba vyplniť požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layer - vybrať vstupný DMR. 

• Mask layer - vybrať vektorovú vrstvu, podľa ktorej sa vytvorí výrez z DMR. 

• Source CRS – vybrať súradnicový systém vstupného rastra. 

• Target CRS – vybrať súradnicový systém výstupného rastra. 

• Match the extent of the clipped raster to the extent of the mask layer – označiť políčko. 

• Clipped (mask) - zvoliť možnosť Save to File... a zadať názov, formát, umiestnenie výstupného 

rastra. 
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Výrez podľa rastrovej vrstvy 

Výrez z rastra DMR podľa priestorového ohraničenia (Extent) rastrovej vrstvy (napr. rastra 

Ortofotomozaiky alebo ZBGIS rastra)  je možné urobiť pomocou nástroja  Clip raster by extent, ktorý 

sa nachádza v paneli Raster → Extraction: 

 
 
Po spustení toho nástroja sa objaví okno, kde treba vyplniť požadované parametre a potom kliknúť 

na tlačidlo Run: 

• Input layer - vybrať vstupný raster DMR. 

• Cliping extent - kliknúť na ikonku   a vybrať možnosti Calculate from layer a tam vybrať 

raster, podľa ktorého sa urobí výrez. Príklad pre výrez podľa rastra ortofotomoaziky: 
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• Clipped (extent) - zvoliť možnosť Save to File... a zadať názov, formát, umiestnenie 

výstupného rastra. 

 
 

Výsledný výrez (čiernobiely raster) z DMR podľa zvoleného rastra ortofotomozaiky: 
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12. Export na body vo formáte Shapefile 
 

DMR je možné exportovať na vektorovú vrstvu bodov, ktoré sa budú nachádzať v strede buniek  

pôvodného rastra a hodnoty v poslednom stĺpci ich atribútovej tabuľky budú predstavovať výšku 

DMR zodpovedajúcu danej bunke rastra. Slúži na to nástroj Raster Values to Points, ktorý sa 

nachádza v paneli nástrojov Processing Toolbox → SAGA→ Features – Features-Raster Tools.  

Ako prvý krok je potrebné skontrolovať nastavenie správneho súradnicového systému DMR podľa 

postupu uvedeného v 1. kapitole. Po spustení nástroja Vector<->raster sa otvorí okno, kde treba 

vyplniť požadované parametre a potom kliknúť na tlačidlo Run: 

• Grids - vybrať vstupný DMR. 

• Type - vybrať hodnotu nodes. 

• Shapes - zadať názov, formát (Shapefile) a umiestnenie výstupnej bodovej vrstvy. 

Upozornenie: Názvy priečinkov a súborov, ktoré sa v budú v nástroji používať, by mali byť 
pomenované bez diakritiky a medzier, pretože proces môže skončiť s chybou. 
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Výsledok exportu DMR na bodovú vrstvu: 

 
Tieto body sú len dvojrozmerné, čiže ich geometria neobsahuje súradnicu Z (výšku). Súradnicu Z je 

možné bodom doplniť z posledného stĺpca ich atribútovej tabuľky, ktorý obsahuje hodnotu výšky 

DMR. Použije sa na to nástroj Set Z value, ktorý sa nachádza v paneli nástrojov Processing Tools → 

Vector geometry. Po spustení tohto nástroja sa otvorí okno, kde treba vyplniť požadované 

parametre a potom kliknúť na tlačidlo Run: 

• Input layer - vybrať bodovú vrstvu vytvorenú v predchádzajúcom kroku. 

• Z Value - kliknúť na ikonku  a tam vo Field type: int, double, string a vybrať atribút,  

v ktorom sú uvedené hodnoty výšok buniek DMR (posledná možnosť). 

• Z Added - zadať názov, formát (napr. Shapefile) a umiestnenie výstupnej bodovej vrstvy. 
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Po ukončení procesu skontrolovať zadefinovaný súradnicový systém vytvorenej bodovej vrstvy 

v paneli Layers vo vlastnostiach Properties. V prípade potreby je pre možné nastaviť súradnicový 

systém pomocou funkcie Assign projection, ktorá sa nachádza v paneli Processing Toolbox → Vector 

general: 

 

Otvorí sa okno Assign projection, kde v časti Input layer vybrať bodovú vrstvu a v časti Assigned CRS  

kliknúť na ikonku Select CRS  . Otvorí sa okno Coordinate Reference System Selector, kde sa 

vyberá súradnicový systém. Pre S-JTSK[JTSK03] zadať do políčka Filter číslo 8353, ktorý predstavuje 

jeho EPSG kód. Pre DMR v súradnicovom systéme ETRS89-TM34 zadať do políčka Filter číslo 3046, 

ktoré predstavuje jeho EPSG kód. Vyhľadaný súradnicový systém sa zobrazí v okne Coordinate 

Reference System, kde ho treba označiť ľavým tlačidlom myši a potom ešte kliknúť na tlačidlo OK. 

Nakoniec v okne Assigned projection v druhom políčku Assigned CRS vybrať názov, formát  

(napr. Shapefile) a umiestnenie výstupného súboru a kliknúť na tlačidlo Run: 
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13. Export do textového formátu CSV 
 

Bodovú vrstvu vo formáte Shapefile vytvorenú z DMR podľa postupu uvedeného v 12. kapitole je 

možné vyexportovať do textového formátu CSV ako zoznam súradníc tak, že v paneli Layers kliknúť 

pravým tlačidlom myši na vrstvu a vybrať Export → Save Features As:  

 
 

Otvorí sa okno Save Vector Layer as, kde treba vyplniť požadované parametre a kliknúť na tlačidlo 

OK: 

• Format - vybrať Comma Separated Value [CSV]. 

• File name - zadať názov a umiestnenie výstupného súboru CSV. 

• CRS - vybrať rovnaký súradnicový systém, ako má vstupný súbor. 

• Selected fields to export and their export options – označiť políčka, ktoré sa majú 

vyexportovať do súboru CSV: 1. ID = identifikátor bodu, 2. X = súradnica X, 3. Y = súradnica 

Y, 4. súradnica Z (výška DMR v danom bode) - názov tohto atribútu je zhodný z názvom 

použitého DMR. 

• Layer Options – v časti SEPARATOR sa dá vybrať spôsob oddelenia stĺpcov: COMMA (čiarka), 

TAB (tabulátor), SEMICOLON (bodkočiarka). 
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Ukážka vytvoreného súboru CSV: 
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14. Export do formátu DXF 
 

Bodovú vrstvu vo formáte Shapefile vytvorenú z DMR podľa postupu uvedeného v 12. kapitole je 

možné vyexportovať do formátu DXF pre použitie v CAD softvéroch tak, že paneli Layers kliknúť 

pravým tlačidlom myši na vrstvu, vybrať funkciu Export → Save Feature As.... Otvorí sa okno Save 

Vector Layer as, kde treba vyplniť požadované parametre a kliknúť na tlačidlo OK: 

• Format - vybrať AutoCAD DXF. 

• File name - zadať názov a umiestnenie výstupného súboru DXF. 

• CRS - vybrať rovnaký súradnicový systém, ako má vstupný súbor. 
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Vizualizácia vytvoreného DXF súboru v CAD softvéri Bentley MicroStation V8i: 

 
 

Upozornenie: Vyexportované DXF súbory majú nastavené ako meracie jednotky inches (palce).  

Je to z dôvodu používaného zdrojového súboru header.dxf (jeho umiestnenie v QGIS 3.22.2: 

C:\Program Files\QGIS 3.22.2\share\gdal\), kde je nastavené pri parametroch $MEASUREMENT=0 

(English) a $INSUNITS=1 (Inches) 

Pre konverziu do jednotiek metrov treba tento súbor upraviť v textovom editore (napr. Notepad++ 

atď.) a nastaviť správne hodnoty pre parametre $MEASUREMENT=1 (Metric) a $INSUNITS=6 

(Meters): 

$MEASUREMENT 

70 

     1 

$INSUNITS  

 70 

     6 

Viac informácií o nastavených jednotkách v DXF súbore na stránke: 

https://ezdxf.readthedocs.io/en/stable/concepts/units.html 

 

Po otvorení vytvoreného súboru DXF napr. v softvéri Bentley MicroStation treba skontrolovať 
a nastaviť správne jednotky v projekte v časti Settings → Design File → Working Units: 

▪ pri súradnicovom systéme S-JTSK a ETRS89-TM34 treba v časti Modify Working Unit 
Settings v políčku Master units mať správne nastavené Meters: 

https://ezdxf.readthedocs.io/en/stable/concepts/units.html
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▪ v časti Advanced Setting kliknúť na tlačidlo Edit a v Resolution treba mať nastavené Meter: 

 

Správne nastavenie jednotiek je dôležité z dôvodu, ak sa do projektu budú pridávať aj iné údaje, 
aby sa potom vrstvy spolu správne polohovo zobrazovali. 
 

15. 3D zobrazenie 
 

Na zobrazenie DMR v 3D pohľade je možné použiť funkciu New 3D Map View, ktorá sa nachádza  

v hlavnom menu v paneli View: 

 
Po spustení sa otvorí sa nové mapové okno 3D Map, v ktorom je možné prehliadať DMR v 3D 

zobrazení. V tomto okne treba na začiatku kliknúť na ikonku Configure , kde sa nastavia 

požadované parametre: 
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• Terrain → Type - vybrať hodnotu DEM (Raster layer). 

• Terrain → Elevation - vybrať DMR, podľa ktorého sa vygeneruje a zobrazí 3D terén. 

• Terrain → Vertical scale – zadať mierkový faktor pre výšky (hodnota 1 znamená, že výšky 

budú vykreslené bez zmeny mierky).   

• Terrain → Tile resolution – udáva, koľko vzoriek z vrstvy rastra použiť pre každú dlaždicu 

terénu v 3D zobrazení. Hodnota napr. 16 px znamená, že geometria každej dlaždice bude 

zostavená zo vzoriek výšky v počte 16x16.  Vyššie číslo vytvára detailnejšie dlaždice terénu 

na úkor zvýšenej zložitosti vykresľovania. 

• Terrain → Skirt height - Niekedy je možné pri 3D zobrazení vidieť malé „trhliny“ medzi 

dlaždicami terénu. Zvýšením tejto hodnoty sa pridajú zvislé steny („skirts“) okolo dlaždíc 

terénu, aby sa tieto „trhliny“ skryli.  

 
• Lights → Light Direction -  nastaviť polohu zdroja osvetlenia:  azimut (Azimuth) a výšku 

(Altitude). 

• Lights → Colour - vybrať farbu osvetlenia. 

• Lights → Intensity - nastaviť hodnotu intenzity osvetlenia. 
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• Shadows – pre zobrazenie tieňov v 3D pohľade označiť políčko Show Shadows a nastaviť 

požadované hodnoty parametrov Shadow rendering maximum distance, Shadow bias 

a Shadow map resolution. 

 
• Advanced → Map tile resolution - šírka a výška 2D mapových obrázkov v pixloch používaných 

ako textúry pre dlaždice terénu v 3D zobrazení. Vyššie číslo vytvára detailnejšie dlaždice 

terénu na úkor zvýšenej zložitosti vykresľovania. 

• Advanced → Max. screen error - určuje hranicu, keď sa existujúce dlaždice terénu vymenia 

za podrobnejšie dlaždice (a naopak) - t.j. ako skoro bude 3D zobrazenie používať dlaždice 

vyššej kvality. Nižšie číslo znamená viac detailov v 3D scéne na úkor zvýšenej zložitosti 

vykresľovania. 

• Advanced → Max. groud error – udáva, pri akom rozlíšení terénnych dlaždíc je dobré prestať 

ich v 3D pohľade deliť na podrobnejšie dlaždice (pretože ich rozdelenie by aj tak neprinieslo 

žiadne ďalšie detaily). Táto hodnota obmedzuje hĺbku hierarchie dlaždíc: nižšia hodnota 

zvyšuje hĺbku hierarchie, čím sa zvyšuje zložitosť vykresľovania. 
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Zmena pohľadu v okne 3D View sa ovláda pomocou tlačidiel a pohybom myši (zmena natočenia 

DMR sa vykoná podržaním stredného tlačidla a posúvaním myši) alebo panela nástrojov 

umiestneného v pravej časti okna.  

Ukážka 3D zobrazenia DMR: 
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Ukážka 3D zobrazenia DMP: 

 
 

DMR je tiež možné ofarbiť podľa ortofotomozaiky, ktorá sa dá bezodplatne stiahnuť priamo z 

aplikácie Mapový klient ZBGIS alebo z cloudu na stránke 

https://www.geoportal.sk/sk/zbgis/ortofotomozaika/ 

 Ortofotosnímky treba do QGIS pridať cez nástroj Layer → Add Layer → Add Raster Layer a v paneli 

Layers ich umiestniť nad vrstvou DMR: 

 
 

 

 

 

 

 

 

 

 

https://zbgis.skgeodesy.sk/mkzbgis?bm=zbgis&z=8&c=19.530000,48.800000#/export
https://www.geoportal.sk/sk/zbgis/ortofotomozaika/
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16. 3D zobrazenie objektov na DMR 
 

QGIS umožňuje okrem 3D zobrazenia samotného DMR aj 3D zobrazenie objektov umiestnených na 

ňom (napr. budovy zo ZBGIS alebo INSPIRE). Do projektu je potrebné okrem DMR pripojiť aj 

vektorovú vrstvu objektov, ktoré sa majú nad DMR zobraziť. Aby sa aj tieto objekty sa zobrazili v 3D 

tvare, je potrebné, aby v atribútovej tabuľke mali uvedené svoje výšky nad terénom (napr. pre 

budovy zo ZBGIS je to atribút HGT, pre budovy z INSPIRE je to atribút heightAboveGround). Ako prvý 

krok je treba zobraziť DMR v 3D mapovom okne pomocou nástroja New 3D Map View podľa postupu 

uvedeného v 15. kapitole. Následne do projektu treba pridať požadovanú vektorovú vrstvu objektov 

cez nástroj Add Vector Layer, ktorý sa nachádza v paneli Layer → Add Layer. Objekty z tejto vrstvy 

sa potom zobrazia v okne 3D Map priamo na povrchu DMR v 2D tvare.  

Príklad zobrazenia budov z INSPIRE témy Buildings, ktoré je možné bezodplatne stiahnuť 

v súradnicovom systéme ETRS89 (kód EPSG:4258) na stránke 

https://www.geoportal.sk/sk/inspire/ukladacie-sluzby/ : 

 

 
Budovy zo ZBGIS je možné zakúpiť cez portál Produkty a služby. 

 

Pre zobrazenie 3D tvaru objektu treba vo vlastnostiach vrstvy Properties v časti 3D View vyplniť 

požadované parametre a potom kliknúť na tlačidlo OK: 

• V prvom políčku vybrať hodnotu Single symbol. 

• Height – parameter udáva hodnotu výšky spodnej časti objektu nad terénom (DMR) v 3D 

zobrazení.  Ak sa má spodná časť objektu nachádzať priamo na teréne (DMR), tak 

Height=0,00. 

• Extrusion - kliknúť na ikonku  a tam vo Field type: int, double, string vybrať atribút,  

ktorý obsahuje výšku objektu nad povrchom. 

https://www.geoportal.sk/sk/inspire/ukladacie-sluzby/
https://om.skgeodesy.sk/om/
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• Altitude clamping - definujete polohu 3D objektu vzhľadom na podkladový povrch terénu 

(DMR): 

o  Terrain alebo Relative – 3D  objekt (jeho spodná časť) bude umiestený priamo na 

teréne. 

o Absolute – 3D objekt (jeho spodná časť) bude umiestnený na základnej výškovej 

rovine, ktorá má hodnotou výšky rovnú 0 m. 

• Altitude binding - definuje, akým spôsobom je objekt pripevnený k terénu:  

o Centroid - na teréne sa nachádza len stredový bod (centroid) objektu. 

o  Vertex - na teréne sa nachádza každý vertex objektu. 

• Rendered facade – vybrať časti objektov, ktoré sa majú v 3D zobraziť: 

•  Walls and Roofs – kompletný tvar (steny aj strecha) objektu. 

 
•  Walls – len bočné steny objektu. 
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•  Roofs – len vrchná časť (strecha) objektu. 

 
•  No Facades – objekty sa nezobrazia. 

• Ambient - vybrať farbu objektov. 

• Edges – označiť políčko, ak je treba zvýrazniť hrany budov a nastaviť ich šírku (Width) a farbu 

(Color). 
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Príklad 3D zobrazenia budov z INSPIRE témy Buildings na DMR 5.0: 

 
 

V prípade potreby zobraziť v 3D pohľade nad DMR len 2D objekty, ktoré nemajú hodnotu výšky nad 

terénom, ako sú napr. katastrálne parcely či cesty, tak v takomto prípade stačí v paneli Layers 

umiestniť takúto vektorovú vrstvu nad vrstvu DMR a vo vlastnostiach vrstvy Properties → Symbology 

im nastaviť požadovanú symboliku: 
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V časti Properties → 3D View nastaviť No Symbols: 

 

Príklad 3D zobrazenia katastrálnych parciel  a ciest z INSPIRE témy Transport networks 

(https://www.geoportal.sk/sk/inspire/ukladacie-sluzby/) nad DMR: 

 
 
 
 
 
 

https://www.geoportal.sk/sk/inspire/ukladacie-sluzby/
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Príklad 3Dzobrazneia budov, parciel a ciest nad DMR: 

 

 

Pre 3D zobrazenie objektov nad DMR je taktiež možné použiť klasifikované mračno bodov. Postup 

je uvedený v návode https://www.geoportal.sk/files/zbgis/lls/navod-mracno-bodov-qgis.pdf. 

 
 

 

 

 

 

 

 

 

https://www.geoportal.sk/files/zbgis/lls/navod-mracno-bodov-qgis.pdf
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17. Pridanie výšky terénu vektorovým objektom 
 

Ak je potrebné vektorovým objektom doplniť výšky (súradnice Z) vertexov podľa výšky terénu  

z DMR, je možné použiť nasledujúci postup: 

1) Do projektu pridať DMR, podľa ktorého sa budú výšky určovať, pomocou funkcie Layer→ 

Add Layer → Add Raster Layer (1. kapitola). 

 
2) Po projektu pridať vektorovú vrstvu napr. vo formáte ESRI Shapefile pomocou funkcie Add 

Vector Layer, ktorá sa nachádza v pabneli Layer → Add Layer: 

 
3) Na pridanie výšok z DMR jednotlivým bodom (vertexom) vektorvej vrstvy slúži nástroj 

Drape (set Z value from raster), ktorý sa nachádza v paneli Processing Toolbox→Vector 

geometry: 
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Po spustení tohto nástroja sa otvorí okno Drape (sez Z value from raster), kde treba vyplniť 

požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layer – vybrať vstupnú vektorovú vrstvu. 

• Raster layer – vybrať raster DMR, z ktorého sa budú určovať výšky vertexov. 

• Updated - zadať názov, formát a umiestnenie výstupnej vektorovej vrstvy. 

 
Výsledkom je vektorová vrstva, ktorej všetky vertexy jednotlivých objektov majú doplnené 

súradnice Z podľa výšky terénu z DMR v mieste polohového prieniku vertexu s bunkou rastra 

DMR. Ak vertexy vstupnej vektorovej vrstvy už mali hodnoty Z vyplnené, pôvodné hodnoty sa 

prepíšu podľa výšok z DMR.  

 

4) Pridané výšky (súradnice Z) vertexov jednotlivých objektov je možné skontrolovať tak,  

že v paneli Layers kliknúť na vytvorenú vektorovú vrstvu: 

 
Potom spustiť nástroj Toggle Editing, ktorý sa nachádza v paneli Layer alebo po kliknúť na 

ikonku  v paneli nástrojov: 
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Po tomto kroku sa aktivujú aj ostatné nástroje pre editáciu, z nich vybrať nástroj Vertex Tool 

po kliknutí na ikonku  a následne v mapovom okne kliknúť pravým tlačidlom myši na 

zvolený objekt. Otvorí sa okno Vertex Editor, kde sú zobrazené súradnice (x, y, z) všetkých 

vertexov daného objektu: 

 
 

18. Analýza viditeľnosti 
 

Pomocou digitálnych výškových modelov DMR alebo DMP je možné taktiež robiť analýzy 

potencionálnej viditeľnosti terénu alebo objektov zo zadaných bodov nachádzajúcich na ich 

povrchu. Môžu sa tak identifikovať oblasti, z ktorých je alebo nie je vidieť na zvolený bod. Alebo 

identifikovať prekážky, ktoré zabraňujú napr. šíreniu signálu z vysielačov. Slúži na to nástroj (plugin) 

Visibility Analysis (podrobnejšie informácie: https://www.zoran-cuckovic.from.hr/QGIS-visibility-

analysis/help_qgis3.html), ktorý sa dá nainštalovať podobným postupom, ako je uvedený v 8. 

kapitole. Nainštalovaný nástroj sa potom nachádza v paneli Processing Toolbox: 

https://www.zoran-cuckovic.from.hr/QGIS-visibility-analysis/help_qgis3.html
https://www.zoran-cuckovic.from.hr/QGIS-visibility-analysis/help_qgis3.html
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Ako prvý krok je potrebné si vytvoriť vektorovú bodovú vrstvu (napr. vo formáte Shapefile) 

obsahujúcu  stanoviská (pozorovacie body), na ktorých sa bude robiť analýza viditeľnosti.  

Príklad umiestnenia plánovaného vysielača (červený bod) na DMP: 

 
Pomocou nástroja Create viewpoints sa týmto bodom doplnia parametre potrebné pre analýzu 

viditeľnosti. Po kliknutí na tento nástroj sa otvorí okno, kde treba vyplniť požadované parametre a 

potom kliknúť na tlačidlo Run: 
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• Observer location(s) – vybrať vstupnú vektorovú bodovú vrstvu obsahujúcu stanoviská 

(miesta pozorovania), na ktorých sa bude robiť analýza. 

• Digital elevation model – vybrať DMR, na ktorom sa bude robiť analýza. 

• Observer ids – v prípade potreby vybrať atribút, ktorý bude slúžiť ako identifikátor stanovísk. 

Ak zostane nevyplnený, automaticky sa použijú primárne identifikátory bodov zo súboru. 

• Radius of analysis – zadať polomer oblasti (v metroch) v okolí stanovísk, v rámci ktorej sa 

bude robiť analýza. 

• Field value for analysis radius – zvoliť v prípade, ak sa vo vstupnej bodovej vrstve  

so stanoviskami nachádza atribút, ktorý obsahuje polomery oblastí pre analýzu. 

• Observer height – zadať výšku stanovísk nad terénom v metroch. 

• Field value for observer heught - zvoliť v prípade, ak sa vo vstupnej bodovej vrstve  

so stanoviskami nachádza atribút, ktorý obsahuje ich výšky nad terénom. 

• Target height – v prípade potreby zadať hodnotu výšku cieľa (v metroch), ktorá bude pridaná 

k výške DMR vo všetkých oblastiach, na ktorých sa bude robiť analýza. 

• Field value for target height – zvoliť v prípade, ak sa vo vstupnej bodovej vrstve  

so stanoviskami nachádza atribút, ktorý obsahuje hodnotu výšky cieľa, ktorá bude pridaná 

k výške DMR vo všetkých oblastiach, na ktorých sa bude robiť analýza. 

• Output layer - zadať názov, formát (napr. Shapefile) a umiestnenie výstupnej bodovej vrstvy. 
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Po príprave vrstvy so stanoviskami (Viewpoints) sa dá vytvoriť rastrová mapa viditeľnosti. Podľa 

výsledkov analýzy viditeľnosti budú jednotlivé bunky rastra tejto mapy nadobúdať hodnoty: 

• 1 = viditeľná zo stanoviska, 

• 0 = neviditeľná zo stanoviska. 

Na vytvorenie tejto mapy sa dá použiť nástroj Viewshed . Po kliknutí na tento nástroj sa otvorí okno, 

kde treba vyplniť požadované parametre a potom kliknúť na tlačidlo Run: 

• Analysis Type – vybrať metódu, ktorá sa použije pri analýze viditeľnosti:  

- Binary viewshed: vytvorí mapu viditeľnosti, kde bude každej bunke rastra priradená 

hodnota 1 (true)/0 (false) čiže viditeľné/neviditeľné. 

- Depth below horizon - poskytne hĺbku, v ktorej ležia neviditeľné časti terénu. Hodnota 

produkovaná týmto modulom môže byť chápaná ako teoretická výška, ktorú by mal 

objekt dosiahnuť, aby sa objavil na horizonte ako viditeľný zo zvoleného 

pozorovacieho bodu. 

- Horizon: určenie vonkajších okrajov zorného poľa. 
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• Observer location(s) – vybrať vstupný vektorový súbor obsahujúci stanoviská (Viewpoints), 

na ktorých sa bude robiť analýza. 

• Take in account Earth curvate – vybrať v prípade, ak je potrebné do výpočtu zahrnúť aj 

zakrivenie Zeme (pri malých vzdialenostiach je zanedbateľné). 

• Atmoshpheric refraction – v prípade potreby zadať hodnotu atmosferickej refrakcie (alebo 

použiť prednastavenú hodnotu 0,13). 

• Output file - zadať názov, formát (napr. TIFF) a umiestnenie výstupného rastra. 

 

Výsledná mapa viditeľnosti DMP zo zvoleného stanoviska (červený bod): 
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3D zobrazenie výsledkov analýzy viditeľnosti na DMP: 

 
Upozornenie: Pri generovaní DM 1.0 poskytovaného ÚGKK SR sú z mračna bodov použité aj body 
elektrických vedení, káblov či potrubí, ktoré na DMP vytvoria „zvislé steny“, príklad: 

 
Tieto objekty ale v skutočnosti nemusia byť prekážkou vo viditeľnosti objektov. 
 

19. Výpočet objemu 
 

Na výpočet objemu časti terénu alebo objektov podľa DMR alebo DMP slúži nástroj Raster surface 

volume, ktorý sa nachádza v paneli Processing Toolbox→ Raster analysis: 
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Objem vybranej časti DMR alebo DMP sa určuje podľa vzorca: 

                                                       𝑉 = ∑ 𝑝𝑖. (𝐻𝑝𝑖𝑥𝑒𝑙𝑖
− 𝐻0)

𝑛

𝑖=1

                        (1) 

kde  p - plocha pixela, 
 Hpixel - hodnota pixela (nadmorská výška), 

H0 - hodnota nadmorskej výšky zvolenej referenčnej roviny (base level), od ktorej sa bude 
   objem určovať, 

 n - počet pixelov rastra.  

 
 

Presnosť výpočtu objemu závisí od priestorového rozlíšenia rastra resp. veľkosti pixelu. Objem sa 
určí presnejšie pri DMR s väčším priestorovým rozlíšením (obr. 2) ako pri DMR s menším rozlíšením 
(obr. 3), pretože znázorňuje priebeh terénu detailnejšie: 
 

 
 
 

Ako prvý krok si treba pripraviť výrez časti DMR alebo DMP, ktorého objem je potrebné určiť, podľa 
postupu uvedeného v 11. kapitole alebo si priamo z Mapového klienta ZBGIS vyexportovať 
požadovanú časť pomocou ohrady: 

https://zbgis.skgeodesy.sk/mkzbgis/sk/teren/export?
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Vybraná časť DMR zobrazená v 3D (15. kapitola): 

 
Po spustení nástroja Raster surface volume sa otvorí okno, kde treba vyplniť požadované 

parametre a potom kliknúť na tlačidlo Run: 

• Input layer – vybrať DMR alebo DMP zvoleného objektu, ktorý bude použitý na výpočet 

objemu. 

• Base level – zadať hodnotu nadmorskej výšky referenčnej roviny (base level), od ktorej sa 

bude objem počítať (napr. projektovaná výška). O túto výšku budú znížené hodnoty pixelov 

rastra, ktoré vstupujú do výpočtu podľa vzorca (1). 

• Method – vybrať metódu na výpočet objemu: 

➢ Count Only Above Base Level – objem bude počítaný len z časti DMR alebo 

DMP nachádzajúcej sa nad zvolenou referenčnou rovinou (base level), 
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➢ Count Only Below Base Level – objem bude počítaný len z časti DMR alebo 

DMP nachádzajúcej sa pod zvolenou referenčnou rovinou (base level), napr. 

pri výpočte objemov výkopov, jám,.... 

 

• Surface volume report – vybrať možnosť Save to file a zadať názov a umiestnenie 

výstupného súboru vo formáte HTML s výsledkami výpočtu objemu. 

• Surface volume table – vybrať možnosť Save to file a zadať názov, umiestnenie  a formát 

výstupného súboru s tabuľkou obsahujúcou výsledky výpočtu objemu. 
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Výsledný vypočítaný objem v m3 medzi zvolenou referenčnou rovinou (base level) 

a povrchom rastra DMR alebo DMP je možné nájsť: 

a) v okne Log v časti VOLUME: 

 
Po kliknutí sa ikonku  je možné výsledky výpočtu vyexportovať do textového 

súboru. 

 

b) vo výstupnom súbore Surface volume report: 
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20. Export do 3D modelu vo formáte STL 
 

Formát STL (STereoLithography) slúži ako štandard pre 3D tlač, ktorý popisuje povrchovú geometriu 

trojrozmerného objektu a na znázornenie plôch modelu používa sieť trojuholníkov.  

Na export DMR alebo DMP do 3D modelu vo formáte STL v QGIS slúži nástroj (plugin) DEMto3D. 

Tento nástroj je potrebné najprv do QGIS nainštalovať podľa postupu uvedeného v 8. kapitole 

Nainštalovaný nástroj sa nachádza v paneli Raster: 

 

Postup (príklad pre 3D model vytvorený z DMP 1.0 z oblasti Pevnosti Komárno): 

1. Do nového projektu pridať raster DMR alebo DMP podľa postupu uvedeného v 1. kapitole: 

 
2. Spustiť nástroj DEMto3D (DEM 3D printing) a vyplniť požadované parametre. 

Parametre treba zvoliť podľa vlastností vstupného rastra (priestorové rozlíšenie, rozloha 

územia, výškový rozsah), výkonnosti počítača a účelu, na ktorý sa bude súbor STL využívať. 

• Layer to print – vybrať vstupný raster DMR alebo DMP. 

• Print extent – kliknúť na tlačidlo Select layer extent , po čom sa automaticky 

vyplnia v políčkach X a Y súradnice rohov priestorového ohraničenia 3D modelu podľa 

rozsahu vstupného rastra. Po kliknutí na tlačidlo Draw extent  je možné 

v mapovom okne manuálne vyznačiť priestorové ohraničenie modelu. Alebo 

súradnice pravého horného a ľavého dolného rohu ohraničenia modelu vyplniť 

manuálne. 
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• Scale – zadať/vybrať mierku výstupného 3D modelu, napr. 1:1000. Po zadaní mierky sa 

automaticky vyplnia hodnoty Width (šírka) a Length (dĺžka), ktoré predstavujú rozmery 

výstupného 3D modelu v mm. Tiež sa pri parametri Spacing (rozstup trojuholníkov 3D 

modelu) zobrazí odporúčaná hodnota (napr. Recommended  1.0 mm) podľa zadanej 

mierky, rozmerov a priestorového rozlíšenia vstupného rastra, ktorú treba zadať do 

políčka. Ak je potrebné vytvoriť detailnejší model, tak napr. namiesto hodnoty 1.0 mm 

zadať napr. 0.25 mm. Treba ale počítať s tým, že veľkosť vytvoreného STL súboru bude 

potom oveľa väčšia. Ak je potrebné vytvoriť model bez zmeny mierky, tak zadať 1:1, 

kde v tomto prípade Spacing potom bude 1000 mm. Ak sa 3D model zo súboru STL 

použije na 3D tlač, tak treba zvážiť aj parametre tlačiarne (veľkosť modelu, ktorý 

dokáže naraz vytlačiť). 

• Vertical exaggeretion – zadať hodnotu, podľa ktorej sa zmenia výšky. Pri hodnote  

x 1,000 budú zachované pôvodné hodnoty výšok DMR či DMP. Pri hodnote napr.  

x 2,000 sa vstupné hodnoty výšok dvakrát zväčšia, takže výstupný 3D model bude 

výškovo výraznejší. 

• Terrain inversion – Políčko enable označiť v prípade, ak je na výstupe potrebný 

inverzný („obrátený“) 3D model. 

• Divide model: Do prvého políčka (row) zadať počet riadkov a do druhého políčka 

(column) zadať počet stĺpcov, na ktoré bude pôdorys modelu rozdelený. Ak sa zadajú 

hodnoty napr. row=2 a column=2, tak model bude na výstupe rozdelený na 4 časti: 

 
• Height – zadať výšku, ktorá  bude použitá ako referenčná rovina, od ktorej sa bude 

model vytvárať. Napr. použiť minimálnu hodnotu výškového rozsahu DMR uvedenú 

v parametri Lowest point alebo hodnotu blízku tohto parametra. 
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Nakoniec kliknúť na tlačidlo Export to STL, kde zadať umiestnenie a názov výstupného súboru.  

Do názvu výstupného súboru doplniť aj formát .stl: 
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Vytvorený 3D model je možne napr. vo Windows 10 zobraziť a prehliadať pomocou nástrojov              
3D zobrazovač alebo 3D Skicár: 
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Ďalšie príklady 3D modelov vo formáte STL: 

1) 3D model vrchu Kriváň (Vysoké Tatry) vytvorený z Digitálneho modelu reliéfu DMR 5.0: 

 
 

2) Inverzný 3D model vytvorený z Digitálneho modelu reliéfu DMR 5.0 z oblasti Pevnosti 

Komárno: 
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21. Výber objektov podľa výšky a sklonu terénu 
 
 

Výber častí DMR podľa výšky terénu 

 

Na výber častí DMR podľa zvolenej hodnoty výšky sa použije nástroj Raster Calculator, ktorý sa 

nachádza v hlavnom menu paneli Raster: 

 
 

Alebo Raster calculator, ktorý sa nachádza v paneli Processing Toolbox → Raster analysis: 

 
 

Po spustení nástroja sa otvorí okno, kde do políčka Expression zadať podmienku na výber buniek 

rastra, príklad pre výber častí DMR s výškou terénu väčšou ako 200 m: "dmr@1" > 200.  

Do podmienky zadať presný názov vstupného rastra DMR, ktorý je možný vidieť v časti Layers, kde 

stačí dvakrát kliknúť ľavým tlačidlom myši na vrstvu a automaticky sa pridá po políčka Expression. 

V políčku Reference layer(s) (used for automated extent, cellsize, and CRS) vybrať vrstvu DMR 

a kliknúť na tlačidlo OK: 
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V políčku Output CRS vybrať súradnicový systém a v políčku  Output zadať umiestnenie, názov 

a formát výstupného súboru a nakoniec kliknúť na tlačidlo Run: 
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Vstupný DMR: 

 
 
Výsledný raster -  bunky, patriace do územia s nadmorskou výškou nad 200 m, majú hodnotu 1  
a ostatné bunky majú hodnotu 0: 

 
 

Ak je potrebné, aby každá bunka rastra obsahovala pôvodnú hodnotu výšky terénu, tak na začiatku 

v nástroji Raster calculator treba v časti Expression zadať výraz: ("dmr@1" > 200)* "dmr@1". 
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Výsledný raster: 

 
 

 

Výber častí DMR podľa sklonu terénu 

 

Ako prvý krok je potrebné si z DMR vytvoriť raster znázorňujúci sklon terénu podľa postupu 

uvedeného v 10. kapitole: 
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Na výber častí DMR podľa sklonu terénu sa taktiež použije nástroj Raster calculator. Po spustení 

nástroja sa otvorí okno, kde do políčka Expression zadať podmienku na výber buniek rastra, príklad 

pre výber častí DMR so sklonom terénu 3° až 6°: "dmr_sklon@1">=3 AND "dmr_sklon@1"<= 6. 

Do podmienky zadať presný názov vstupného rastra DMR, ktorý je možný vidieť v časti Layers, kde 

stačí dvakrát kliknúť ľavým tlačidlom myši na vrstvu a automaticky sa pridá po políčka Expression. 

V políčku Reference layer(s) (used for automated extent, cellsize, and CRS) vybrať vrstvu DMR 

a kliknúť na tlačidlo OK: 

 
 

V políčku Output CRS vybrať súradnicový systém a v políčku  Output zadať umiestnenie, názov 

a formát výstupného súboru a nakoniec kliknúť na tlačidlo Run: 
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Výsledný raster - bunky, patriace do územia so sklonom terénu od 3° do 6°, majú hodnotu 1  

a ostatné bunky majú hodnotu 0: 

 
Ak je potrebné, aby každá bunka rastra obsahovala pôvodnú hodnotu sklonu terénu, tak na 

začiatku v nástroji Raster calculator treba v časti Expression zadať výraz:  

("dmr_sklon@1">=3 AND "dmr_sklon@1"<= 6)*"dmr_sklon@1". 

 
Výsledný raster: 
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Výber objektov z vektorovej vrstvy podľa výšky alebo sklonu terénu 

 

Na začiatku je potrebné prekonvertovať rastre vytvorené v predchádzajúcich krokoch na vektorovú 

polygónovú vrstvu (napr. vo formáte ESRI Shapefile alebo GeoPackage) pomocou nástroja 

Polygonize (raster to vector), ktorý sa nachádza v paneli Raster → Conversion: 

 

Po spustení nástroja sa otvorí okno, kde treba vyplniť požadované parametre a kliknúť na tlačidlo 

Run (príklad pre raster znázorňujúci územie so sklonom terénu od 3° do 6°): 

▪ Input layer – vybrať vstupný raster (použiť raster, ktorého bunky patriace do územia 

s požadovaným sklonom, majú hodnotu 1 a ostatné bunky majú hodnotu 0). 

▪ Vectorized - zadať názov, formát a umiestnenie výstupného súboru. 
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Výsledkom je vektorová polygónová vrstva: 

 
 

Polygóny, ktoré patria do územia so sklonom terénu od 3° do 6°, je možné identifikovať podľa 

atribútu DN v atribútovej tabuľke, ktorý obsahuje pôvodné hodnoty buniek rastra (0, 1): 
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Vybrať len požadované polygóny pomocou nástroja Select/filter features using form (ikonka ) 

nachádzajúce sa na území so zvoleným sklonom terénu. Po spustení nástroja zadať do políčka DN 

výraz, podľa ktorého sa vyselektujú vybrané objekty: DN=1, kde v políčku napravo treba vybrať 

možnosť Equal to (=) a nakoniec kliknúť na ikonku : 
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Následne je možné vybrané objekty vyexportovať do novej vektorovej vrstvy pomocou nástroja  

Export → Save Selected Features As: 

 
Po spustení nástroja sa otvorí okno Save Vector Layer as, kde treba vyplniť požadované parametre 

a kliknúť na tlačidlo OK: 

• Format - vybrať formát výstupného súboru (napr. GeoPackage, ESRI Shapefile). 

• File name - zadať názov a umiestnenie výstupného súboru. 

• CRS - vybrať rovnaký súradnicový systém, ako má vstupný súbor. 

• Encoding – označiť políčko Save only selected features. 

• Selected fields to export and their export options – označiť všetky políčka.  
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Vyexportovaná vektorová polygónová vrstva znázorňujúca územie so sklonom terénu od 3° do 6°.  

 
 

Pre kontrolu správnosti geometrie vyexportovaných polygónov použiť nástroj Fix geometries, ktorý 

sa nachádza v paneli Processing toolbox → Vector geometry: 
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Po spustení nástroja sa otvorí okno, kde treba vyplniť požadované parametre a potom kliknúť na 

tlačidlo Run: 

• Input layert - vybrať vstupnú vektorovú vrstvu na kontrolu a opravu geometrie. 

▪ Fixed geometries – zadať názov, formát a umiestnenie výstupného súboru s opravenou 

geometriou. 

 
Po tomto kroku je možné podľa vyexportovanej vrstvy vybrať objekty z inej vektorovej vrstvy (napr. 

parcely) na základe ich vzájomnej polohy pomocou nástroja Select by location, ktorý sa nachádza 

v paneli Processing Toolbox → Vector selection: 
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Po spustení nástroja sa otvorí okno, kde teba vyplniť potrebné parametre a kliknúť na tlačidlo Run: 
▪ Select features from – vybrať vstupnú vektorovú vrstvu, z ktorej sa budú vyberať objekty. 

▪ Where the features (geometric predicate) – vybrať metódu, podľa ktorej sa výber objektov 

na základe ich priestorovej polohy uskutoční: 

➢ intersect – táto metóda testuje, či geometria objektu pretína iný objekt z druhej 

vrstvy. V obrázku z príkladu (nižšie) vyberie objekty 1, 2 a 3. 

➢ contain - táto metóda testuje či objekt obsahuje kompletný objekt z druhej vrstvy.  

V obrázku z príkladu nevyberie žiadny objekt. 

➢ disjoint - táto metóda testuje či objekty z dvoch rôznych vrstiev nezdieľajú žiadnu 

spoločnú časť (žiadne prekrývanie alebo dotýkanie sa). V obrázku z príkladu 

vyberie iba objekt 4. 

➢ equal - táto metóda testuje či geometrie objektov z dvoch rôznych vrstiev sú 

úplne rovnaké. V obrázku z príkladu nevyberie žiadny objekt. 

➢ touch - táto metóda testuje či sa objekt dotýka iného objektu z druhej vrstvy. 

V obrázku z príkladu vyberie iba objekt 3. 

➢ overlap - táto metóda testuje či objekt prekrýva iný objekt z druhej vrstvy. 

V obrázku z príkladu vyberie iba objekt 2. 

➢ are within - táto metóda testuje či sa objekt nachádza vnútri iného objektu 

z druhej vrstvy. V obrázku z príkladu vyberie iba objekt 1. 

➢ cross - táto metóda testuje či majú objekty z dvoch rôznych vrstiev spoločné 

niektoré, ale nie všetky, vnútorné body a kríženie objektov má nižší rozmer ako 

geometria jedného z porovnávaných objektov. Napríklad križovanie čiary a inej 

čiary sa vyberie ako bod, križovanie čiary a polygónu sa vyberie ako čiara. Dva 

polygóny sa krížia ako mnohouholník, ktorý ale táto metóda nevyberie. V obrázku 

z príkladu nevyberie žiadny objekt (keďže ide o križovanie dvoch polygónov). 

Príklad priestorového výberu, kde množina údajov, z ktorej chceme vyberať (zdrojová 

vektorová vrstva), sa skladá zo zelených kruhov. Oranžový obdĺžnik je množina 

údajov, s ktorou sa porovnáva. 

 
Zdroj: https://docs.qgis.org/3.16/en/docs/user_manual/processing_algs/qgis/vectorselection.html 

▪ By comparing to the features from – vybrať vektorovú vrstvu, podľa ktorej sa budú objekty 

zo vstupnej vrstvy vyberať. 

 

 

https://docs.qgis.org/3.16/en/docs/user_manual/processing_algs/qgis/vectorselection.html
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▪ Modify current selection by: 

➢ creating new selection – vytvoriť nový výber. 

➢ adding to current selection – vybrané objekty pridať k predtým urobenému 

výberu. 

➢ selecting within current selection – vybrať objekty z predtým urobenému výberu. 

➢ removing from current selection - vybrané objekty odobrať z predtým 

urobeného výberu. 

 

Príklad výberu parciel, ktoré sa kompletne nachádzajú (are within) na území s nadmorskou výškou 

väčšou ako 200 m: 

 
 

Vybrané parcely sú označené žltou farbou: 
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Následne je možné vybrané objekty vyexportovať do novej vektorovej vrstvy pomocou nástroja  

Export → Save Selected Features As. 

 

Podobne by sa postupovalo aj v prípade výberu objektov (napr. parciel) podľa rastra znázorňujúceho 

územia so zvoleným sklonom terénu. 

Príklad výberu parciel, ktorých aspoň časť plochy sa nachádza (intersect) na území so sklonom 

terénu 3° až 6°: 

 
 

Vybrané parcely sú označené žltou farbou: 
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Príklad výberu parciel súčasne podľa výšky a sklonu terénu: 

Výber parciel, ktoré sa nachádzajúce na území: 

1. s nadmorskou výškou nad 200 m, 

2. so sklonom terénu iným ako 3° až 6°. 

Do projektu pridať všetky potrebné vektorové vrstvy. Ako prvé treba urobiť výber objektov 

nachádzajúcich sa kompletne (are within) na území so zvolenou nadmorskou výškou terénu, 

následne urobiť druhý výber objektov, ktorých žiadna časť plochy sa nenachádza (disjoint) na území 

so zvoleným sklonom terénu, pričom v okne nástroja Select by location v parametri Modify current 

selection by vybrať možnosť selecting within current selection: 

 
Parcely spĺňajúce zadané podmienky sú označené žltou farbou: 

 
Poznámka: Súbory formátu VGI s parcelami katastra nehnuteľností je možné prekonvertovať napr. 

do formátu ESRI Shapefile pomocou Konverznej služby (https://zbgis.skgeodesy.sk/rts/sk/Convert).    

Pre transformáciu súborov VGI medzi realizáciami súradnicového systému S-JTSK je možné použiť 

Rezortnú transformačnú službu (https://zbgis.skgeodesy.sk/rts/sk/Transform). 

https://zbgis.skgeodesy.sk/rts/sk/Convert
https://zbgis.skgeodesy.sk/rts/sk/Transform
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22. Určenie geomorfologických tvarov reliéfu 
 

Na identifikáciu základných geomorfologických tvarov reliéfu je možné použiť nástroj 

r.geomorphon, ktorý sa nachádza v paneli Processing toolbox → GRASS → Raster: 

 
Viac podrobnejších informácií o nástroji a princípe výpočtu je uvedených na stránke: 
http://wgbis.ces.iisc.ernet.in/grass/grass70/manuals/addons/r.geomorphon.html 

 

Po spustení nástroja sa otvorí okno, kde treba vyplniť požadované parametre a potom kliknúť na 

tlačidlo Run: 

▪ Name of input elevation raster map – vybrať vstupný raster DMR. 

▪ Outer search radius – zadať hodnotu pre polomer hľadania (search radius), ktorý bude 

ohraničovať oblasť výpočtu od vybranej bunky rastra, v jednotkách veľkosti bunky rastra (napr. 

Outer search radius = 4 pri DMR s priestorovým rozlíšením  1 x 1 m bude predstavovať 

vzdialenosť 4 m). Použitie väčších hodnôt sa rovná klasifikácii terénu zo širšej perspektívy, zatiaľ 

čo použitie menších hodnôt sa rovná klasifikácii terénu z lokálneho hľadiska. 

▪ Flatness treshold – zadať hodnotu pre „krajnú hodnotu plochosti“ (flatness treshold) v stupňoch, 

ktorá bude použitá pri určovaní jednotlivých tvarov reliéfu. Stanovuje hodnotu, podľa ktorej 

budú jednotlivé časti reliéfu považované za rovinu. Čím menší uhol sa v zvolí, tým bude výsledok 

podrobnejší a budú v ňom detailnejšie zachytené aj menšie terénne nerovnosti. 

▪ Most common geomorphic forms – zadať názov, formát a umiestnenie výstupného rastra. 

Pri voľbe parametrov Outer search radius a Flatness treshold treba brať do úvahy aj priestorové 

rozlíšenie a výškovú členitosť použitého DMR, a tiež s akou podrobnosťou majú byť 

geomorfologické tvary reliéfu určené. Pri DMR s väčším priestorovým rozlíšením (napr. 0,25 m), 

z dôvodu veľkej podrobnosti údajov, ideálne zvoliť vyššie hodnoty zadávaných parametrov pre 

zvýraznenie hlavných zlomových línií terénu. Ukážky výsledkov pri použití rôznych vstupných 

parametrov sú uvedené nižšie. 

http://wgbis.ces.iisc.ernet.in/grass/grass70/manuals/addons/r.geomorphon.html
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Nástroj vytvorí geomorfologickú mapu (raster), kde každá bunka rastra má priradenú vypočítanú 

hodnotu 1 až 10, ktorá zodpovedá danému geomorfologickému tvaru reliéfu: 
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Legenda pre vytvorený raster: 
Farba – hodnota bunky rastra – geomorfologický tvar reliéfu 

 
Zdroj: http://wgbis.ces.iisc.ernet.in/grass/grass70/manuals/addons/r.geomorphon.html 
 

Príklady: 

1) Vstupný DMR (rovinaté územie): 

 
 

Určené geomorfologické tvary reliéfu: 

 

http://wgbis.ces.iisc.ernet.in/grass/grass70/manuals/addons/r.geomorphon.html
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2) Vstupný DMR (hornaté územie): 

 
 

Určené geomorfologické tvary reliéfu: 

 
 

Porovnanie zobrazenia násypu cesty na ortofotomozaike a rastri s geomorfologickými tvarmi 
reliéfu, kde je možné identifikovať svah násypu (žltá farba), jeho vrchná hrana (červená farba), 
spodná hrana (zelená farba) a rovná plocha vozovky (sivá farba): 
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Príklady s použitím rozličných hodnôt parametra Flatness treshold pre DMR s priestorovým 

rozlíšením 1 x 1 m: 

 
 

a) výsledný raster - parameter Outer search radius = 4, Flatness treshold = 1°: 
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b) výsledný raster - parameter Outer search radius = 4, Flatness treshold = 4°: 

 
 

c) výsledný raster - parameter Outer search radius = 4, Flatness treshold = 6°: 
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Príklady s použitím rozličných hodnôt parametrov Outer search radius a Flatness treshold pre DMR 

s priestorovým rozlíšením 0,25 x 0,25 m: 

 
 

a) výsledný raster - parameter Outer search radius = 4, Flatness treshold = 4°: 
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b) výsledný raster - parameter Outer search radius = 16, Flatness treshold = 8°: 

 
 

c) výsledný raster - parameter Outer search radius = 16, Flatness treshold = 12°: 
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Určené geomorfologické tvary reliéfu z rastrového formátu je možné vyexportovať na vektorovú 

vrstvu (napr. vo formáte GeoPackage, ESRI Shapefile) pomocou nástroja Polygonize (raster to 

vector), ktorý sa nachádza v paneli Raster → Conversion: 

 

Po spustení nástroja sa otvorí okno, kde treba vyplniť požadované parametre a potom kliknúť na 

tlačidlo Run: 

▪ Input layer – vybrať vstupný raster. 

▪ Vectorized - zadať názov, formát a umiestnenie výstupného súboru. 
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Výsledkom je vektorová polygónová vrstva, kde každý polygón reprezentuje geomorfologický tvar 
reliéfu podľa buniek rastra: 

 
 

Výstupnej vektorovej vrstve treba skontrolovať súradnicový systém v Properties v časti Source.  
V prípade hodnoty Unknown CRS alebo Invalid projection vrstve priradiť správny súradnicový systém 
podľa použitého rastra DMR pomocou nástroja Processing Toolbox  → Vector general → Assign 
projection. 
 

Jednotlivé typy geomorfologických tvarov reliéfu je možné rozlíšiť podľa atribútu DN v atribútovej 

tabuľke, ktorý obsahuje pôvodné hodnoty buniek rastra: 
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V prípade potreby je možné vyexportovať do novej vektorovej vrstvy len vybrané typy 

geomorfologických tvarov reliéfu pomocou nástroja Select/filter features using form (ikonka ). Po 

spustení nástroja zadať do políčka DN výraz, podľa ktorého sa vyselektujú vybrané objekty. Príklad 

pre selekciu údolí: DN=9, kde v políčku napravo treba vybrať možnosť Equal to (=) a nakoniec kliknúť 

na ikonku : 
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Následne je možné vybrané objekty vyexportovať do novej vektorovej vrstvy pomocou nástroja  

Export → Save Selected Features As: 

 
Otvorí sa okno Save Vector Layer as, kde treba vyplniť požadované parametre a potom kliknúť na 

tlačidlo OK: 

• Format - vybrať formát výstupného súboru (napr. GeoPackage, ESRI Shapefile). 

• File name - zadať názov a umiestnenie výstupného súboru. 

• CRS - vybrať rovnaký súradnicový systém ako má vstupný súbor. 

• Encoding – označiť políčko Save only selected features. 

• Selected fields to export and their export options – označiť všetky políčka.  
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Vyexportované údolia vo vektorovom tvare v 3D zobrazení na DMR vo forme Hillshade: 

 
 

DMR so znázornenými geomorfologickými tvarmi reliéfu v 3D zobrazení: 

 
 

Taktiež je možné raster s geomorfologickými tvarmi reliéfu vytvorený nástrojom r.geomorphon: 

▪ rozdeliť na menšie časti podľa postupu uvedeného v 11. kapitole, 

▪ vyexportovať na vektorovú bodovú vrstvu vo formáte ESRI Shapefile podľa postupu 

uvedeného v 12. kapitole (nie je vhodné použiť pre DMR s príliš veľkou rozlohou a veľkým 

priestorovým rozlíšením z dôvodu obmedzení formátu Shapefile na maximálny počet 

objektov a veľkosť súboru): 
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Jednotlivé typy geomorfologických tvarov reliéfu je možné rozlíšiť podľa atribútu, ktorý 

obsahuje pôvodné hodnoty buniek rastra. Tento atribút je pomenovaný podľa názvu 

vstupného rastra. Takže je možné vyselektovať len vybrané typy geomorfologických tvarov 

reliéfu a vyexportovať do novej vrstvy. Bodom je možné priradiť výšku terénu z DMR podľa 

postupu uvedeného v 17. kapitole. Ďalej je možné túto bodovú vrstvu vyexportovať do 

formátu CSV podľa postupu uvedeného v 13. kapitole alebo DXF podľa postupu uvedeného 

v 14. kapitole. 

 

Vizualizácia vytvorenej bodovej vrstvy vo formáte DXF v CAD softvéri Bentley MicroStation V8i na 

podklade DMR vo forme Hillshade (0,25 m pixel): 

➢ údolie 
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➢ vrchná hrana svahu 

 
 

3D zobrazenie vytvorenej bodovej vrstvy údolí v softvéri Bentley MicroStation V8i: 
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23. Vytvorenie DMR z vektorovej bodovej vrstvy 
 

Pre vytvorenie DMR alebo DMP vo forme rastra je potrebné pripraviť vektorovú bodovú vrstvu 

(napr. vo formáte Shapefile alebo GeoPackage), ktorá bude obsahovať atribút, kde bude uvedená 

výška bodu (napr. zamerané body na teréne pomocou GNSS): 

 
 

Túto bodovú vrstvu treba pridať do projektu pomocou nástroja Add Vector Layer, ktorý sa 

nachádza v paneli Layer → Add Layer: 
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Pre vytvorenie DEM z vektorovej vrstvy pravidelne alebo nepravidelne rozložených bodov je možné 

použiť nástroj Processing Toolbox → SAGA → Raster – Rasterizing → Natural Neighbour, ktorý pre 

vytvorenie rastra používa interpolačnú metódu Natural Neighbour: 

 
Po spustení nástroja treba vyplniť požadované parametre a potom kliknúť na tlačidlo Run: 

• Points – vybrať vstupnú bodovú vrstvu, podľa ktorej sa vytvorí DMR. 

• Attribute – vybrať atribút, kde je uvedená výška bodov. 

• Output extent – zvoliť možnosť Calculate from Layer a tam vybrať bodovú vrstvu, 

podľa ktorej sa nastaví priestorový rozsah výstupného rastra DMR. 

• Cellsize – zadať veľkosť bunky (priestorové rozlíšenie) výstupného rastra DMR. 

• Method – vybrať metódu použitú pri interpolácii a vytváraní rastra DMR (napr. 

Sibson). 

• Target Grid – zadať názov a umiestnenie výstupného rastra DMR vo formáte SDAT.  

 
Formát výstupného DMR je SDAT. Pre export do iného formátu (napr. GeoTIFF) je možné použiť 

postup uvedený v 2. kapitole. 
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Pre tvorbu DMR je ideálne, ak sú body rozložené rovnomerne napr. približne v tvare pravouhlej 

mriežky. Podľa účelu použitia DMR treba zvoliť hustotu/rozostup bodov. Pre vytvorenie 

podrobnejšieho DMR napr. pre presnejší výpočet kubatúry, treba mať k dispozícii hustejšiu sieť 

bodov. 

Výsledný raster DMR: 
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24. Spojenie rastrov DMR 
 

Spojenie (zlúčenie) viacerých rastrov DMR alebo DMP (napr. vyexportovaných podľa hraníc 

katatraálnych území z webovej aplikácie Mapový klient ZBGIS) do jedného súvislého rastra je možné 

pomocou nástroja Merge, ktorý sa nachádza v paneli Processing Toolbox → GDAL→ Raster 

miscellaneous: 

 
Po spustení nástroja treba vyplniť potrebné parametre a potom kliknúť na tlačidlo Run: 

• Input Layers – vybrať vstupné rastre. 

 

https://zbgis.skgeodesy.sk/mkzbgis/sk/teren/export?
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• Output data type - vybrať možnosť Float32. 

• Advanced Parameters → Assign specified nodata value to output – zadať hodnotu pre 

prázdne bunky rastra (napr. -9999), ktoré budú predstavovať  hodnoty No Data. Tieto bunky 

slúžia len na doplnenie mriežky rastra do úplného tvaru (obdĺžnik, štvorec) a neobsahujú 

hodnoty výšky. Pri zobrazení sa potom budú tieto bunky automaticky zobrazovať ako 

transparentné (priehľadné) a nebudú tak prekrývať ostatné vrstvy v mapovom okne. 

• Merged - zvoliť možnosť Save to File a zadať názov, formát (napr. TIF files) a umiestnenie 

výstupného rastra. 
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Výsledný spojený raster DMR: 
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Hodnoty pre No Data bunky rastra je možné zistiť v Properties → Information v časti Bands: 

 
 

Aby sa tieto bunky automaticky zobrazovali ako transparentné, treba v časti Properties → 

Transparency skontrolovať, či je označená políčko No data value: 
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25. Orientácia terénu voči svetovým stranám 
 

Na vytvorenie rastra orientácie (expozíce) reliéfu (DMR) voči svetovým stranám slúži nástroj 

Aspect, ktorý sa nachádza v paneli Raster→Analysis: 

 
Aspekt (expozícia) vyjadruje smer alebo azimut kompasu, ku ktorému smeruje povrch reliéfu. 
Určenie expozícia reliéfu voči svetovým stranám spočíva v konštrukcii izotangent – čiar, ktoré 
spájajú body s rovnakou orientáciou reliéfu voči svetovým stranám. Vytvorená rastrová vrstva 
obsahuje bunky, ktorých hodnoty sú od 0 do 360. Tieto hodnoty vyjadrujú smer (azimut) sklonu 
reliéfu, začínajúc od severu (0°) a pokračujúc v smere hodinových ručičiek: 

  
 (Zdroj: https://docs.qgis.org/3.16/en/docs/user_manual/processing_algs/qgis/rasterterrainanalysis.html) 
 

Tab.  Svetové strany a zodpovedajúce azimuty (hodnoty buniek vytvoreného rastra orientácie terénu) 

Svetová strana Azimut [°] 

Sever 0-22,5  –  337,5-360 

Severovýchod 22,5 – 67,5 

Východ 67,5 – 112,5 

Juhovýchod 112,5 – 157,5 

Juh 157,5 – 202,5 

 Juhozápad 202,5 – 247,5 

Západ 247,5 – 292,5 

Severozápad 292,5 – 337,5 

 

 

 

 

 

https://docs.qgis.org/3.16/en/docs/user_manual/processing_algs/qgis/rasterterrainanalysis.html
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Po spustení nástroja Aspect vyplniť požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layer – vybrať  vstupný raster DMR. 

• Aspect – zadať umiestnenie, názov a formát výstupného rastra. 

 

Nastavenie symboliky rastra orientácií terénu voči svetovým stranám (4. kapitola) 
Vo vlastnostiach vrstvy Properties → Symbology v časti Render type vybrať možnosť Singleband 
pseudocolor, v časti Interolation vybrať Discrete, v časti Color ramp vybrať požadovanú farebnú 
škálu, v časti Mode vybrať možnosť Equal interval, v časti Classes (počet tried v legende) zadať 9, 
upraviť hodnoty intervalov farebnej škály pri Value (0° a 360° = Sever, 45° = Severovýchod, 90° = 
Východ, 135° = Juhovýchod, 180° = Juh, 225° = Juhozápad, 270° = Západ, 315° = Severozápad): 
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Potom je možné tiež upraviť farby v parametri Color (napr. aby pri hodnotách 0 a 360 boli nastavené 
rovnaké farby) a vyplniť hodnoty v časti Label, ktoré sa budú zobrazovať ako popis symboliky 
v panely Layers: 

 
 

Nakoniec kliknúť na tlačidlá Apply  a OK: 
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Vstupný DMR: 

 
 

Výsledný raster orientácie (expozície) reliéfu voči svetovým stranám: 

 

Na výber častí DMR podľa zvolenej hodnoty orientácie terénu sa použije nástroj Raster Calculator, 

ktorý sa nachádza v hlavnom menu paneli Raster alebo Raster calculator, ktorý sa nachádza v paneli 

Processing Toolbox → Raster analysis, podobným spôsobom ako je uvedený v 21. kapitole. 
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Po spustení nástroja Raster calculator sa otvorí okno, kde do políčka Expression zadať podmienku 

na výber buniek rastra. Príklad pre výber častí DMR orientovaných južným smerom (J, JV a JZ): 

"dmr_orientacia@1" > 112.5 AND "dmr_orientacia@1" < 247.5 . Do podmienky zadať presný názov 

vstupného rastra orientácie DMR voči svetovým stranám, ktorý je možný vidieť v časti Layers, kde 

stačí dvakrát kliknúť ľavým tlačidlom myši na vrstvu a automaticky sa pridá po políčka Expression. 

V políčku Reference layer(s) (used for automated extent, cellsize, and CRS) vybrať vrstvu DMR 

a kliknúť na tlačidlo OK: 

 
 

V políčku Output CRS vybrať súradnicový systém a v políčku  Output zadať umiestnenie, názov 

a formát výstupného súboru a nakoniec kliknúť na tlačidlo Run: 
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Výsledný raster, ktorého bunky s hodnotou 1 zodpovedajú zadanej podmienke - sú orientované na 

J, JV alebo JZ: 

 
 

Ak je potrebné, aby každá bunka rastra obsahovala pôvodnú hodnotu azimutu orientácie reliéfu, 

tak na začiatku v nástroji Raster calculator treba v časti Expression zadať výraz:  

("dmr_orientacia@1" > 112.5 AND "dmr_orientacia@1" < 247.5) * "dmr_orientacia@1" : 
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26. Vytvorenie tlačových výstupov 
 

Obsah mapového okna (2D aj 3D) je možné vytlačiť na tlačiarni alebo vyexportovať do rôznych 

formátov napr. PDF, PNG, JPEG alebo SVG pomocou nástroja New Print Layout, ktorý sa nachádza 

v paneli Project: 

 
 

Po spustení sa objaví okno Create print layout, kde treba zadať názov tlačového výstupu a kliknúť 

na tlačidlo OK: 
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Následne sa otvorí okno Print Layout, kde kliknúť tlačidlom myši do bieleho obdĺžnika v strede okna, 

ktorý reprezentuje plochu pre tlač. Po kliknutí vybrať možnosť Page Properties: 

 

Potom v pravom paneli Items v časti Items properties je možné nastaviť formát (Size), orientáciu 

(Orientation) strany pre tlač a farbu pozadia (Background): 
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Pre tlač 2D mapy v ľavom paneli nástrojov kliknúť na tlačidlo Add Map  a v okne pre tlač nakresliť 

obdĺžnik pomocou myši, ktorý bude predstavovať priestorové ohraničenie mapového okna: 

 

 

V pravom paneli Items v časti Items Properties je možné nastaviť rôzne parametre pre tlač mapy 

napríklad: 

• Scale – mierka mapy, 

• Map rotation – uhol rotácie mapy, 

• CRS – súradnicový systém, v ktorom  sa budú údaje zobrazovať. 

Mapu v okne pre tlač je možné posúvať pomocou nástroja Interactively Edit Map Extent . 
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V časti Layout je možné nastaviť napr. rozlíšenie (dpi) vyexportovaného súboru: 
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Pre tlač 3D mapy v ľavom paneli nástrojov kliknúť na tlačidlo Add 3D Map  a v okne pre tlač 

nakresliť obdĺžnik pomocou myši, ktorý bude predstavovať priestorové ohraničenie mapového 

okna. Následne v ľavom paneli Items v časti Items Properties kliknúť na tlačidlo Copy Settings from 

a 3D View a tam vybrať 3D mapové okno z projektu: 

 
 

Po tomto kroku sa zobrazí aktuálny obsah 3D mapového okna z projektu: 
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Taktiež je možné do tlačového výstupu pomocou nástrojov v ľavom paneli doplniť: 

• Add Picture  - obrázok, 

• Add Label  - text, 

• Add Legend  - legenda, 

• Add Scale Bar  - mierka, 

• Add North Arrow  - severka, 

• Add Shape  - geometrický tvar, 

• Add Marker  - značka, 

• Add Arrow  šípka, 

• Add Node Item  - línia alebo polygón, 

• Add Atribute Table  - atribútová tabuľka. 

 

 
 
 

Takto pripravené údaje pre tlač je pomocou nástrojov v hlavnom paneli možné: 

 

a) Print Layout  - vytlačiť v pripojenej tlačiarni, 

b) Export as image  - vyexportovať ako obrázok (PNG, JPG, TIF), 

c) Export as SVG  - vyexportovať ako súbor SVG, 

d) Export as PDF  - vyexportovať ako súbor PDF. 
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Jednotlivé vytvorené mapové výstupy (Print Layouts) je možné nájsť v paneli Project → Layout 

Manager: 

 
 

 


